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Conventions

Boldface Words in boldface type represent programs and commands.

Capitalization Capitalized first letters represent company or product names.

Computer font Words in computer font represent file or path names, 
command syntax statements, prompts or messages that appear 
on your screen, or text you should type on your workstation or 
terminal.

Italics Words in italics represent variables in syntax statements 
or words that are emphasized in the text.

{ } Represents required elements in a syntax statement. 
When several elements are separated by the | symbol, 
you must select one of the elements.

[ ] Represents optional elements in a syntax statement.
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Printing History

New editions are complete revisions of the manual. The printing date for each 
edition is listed below.

Edition 1  (A.03.21)           May 2002

Edition 2  (A.03.30) August 2002

File Locations

The HP OpenView Smart Plug-ins CD-ROM is a collection of OpenView 
Operations Smart Plug-ins (SPIs) and OpenView supplementary management 
applications, for HP OpenView Operations for UNIX. The collection offers the 
convenience of having all SPIs on a single medium with a single Software 
Distributor depot.The Smart Plug-in for MS Exchange Server files are located 
according to operating system, as follows:

Program Files:

cdrom/OV_DEPOT/10.OHPUX.sdtape EXSPI
cdrom/OV_DEPOT/11.OHPUX.sdtape EXSPI
cdrom/OV_DEPOT/SOLARIS.sdtape EXSPI
cdrom/OV_REPORTER/EXCHANGE_SPI_A.03.30/exspi_Reporter.msi

Documentation Files:

OV_DOC/EXCHANGE_SPI_A.03.30/release_notes.pdf
OV_DOC/EXCHANGE_SPI_A.03.30/exspi_users_guide.pdf
OV_DOC/EXCHANGE_SPI_A.03.30/exspi_ref_guide.pdf
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Chapter 1: Exchange SPI Concepts
Introduction
Introduction

This chapter introduces the basic concepts of the HP OpenView Smart Plug-in 

for Microsoft® Exchange Server (Exchange SPI), version A.03.30, which works 
together with HP OpenView Operations for UNIX version 6.0, to monitor 
Microsoft Exchange 5.5 and 2000. 

The chapter includes the following sections:

� What to Look for in the Exchange SPI

� How the Exchange SPI Works

� Customization

� Exchange SPI Reports and Graphs 
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What to Look for in the Exchange SPI

The Exchange SPI adds Exchange 2000 and Exchange 5.5 server-monitoring 
capabilities to HP OpenView Operations for UNIX, allowing you to oversee 
your distributed Exchange environment from a central, easy-to-use console. In 
so doing, you can:

� Increase Exchange availability and performance
� Lower support costs associated with the Exchange service
� Improve capacity management and planning for Exchange

With the Exchange SPI integrated into the OVO console, you can apply the HP 
OpenView performance and problem management processes that you use for 
networks and systems to monitor MS Exchange. The basic process is that 
metrics collected by the Exchange SPI are sent to the HP data collecting agent 
and can be viewed as graphs with HP PerfView, and/or reports with HP Reporter.

After setup, the Exchange SPI will monitor critical Exchange 
application/database resources including:

� Process Monitor (for monitoring the amount of CPU time being used by core 
Exchange processes)

� Inactive Process Monitor (for monitoring core MS Exchange processes for 
activity and status)

� Exchange Service Monitor (for monitoring Exchange Server processes for 
activity levels)

� Data of message processes by Message Transfer Agent and SMTP

� MTA Work Queue and SMTP Queues

� IS Public and Private/Mailbox Average Delivery Time.

This information comes to you in the OpenView Operations console through 
messages, alerts, reports and graphs. 
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How The Exchange SPI Works

The Exchange SPI collects metric information through templates that are 
deployed to OVO managed nodes. 

Templates: Templates are found in template groups under the Exchange version 
folder (Exchange 5.5 or Exchange 2000), in the SPI for MS Exchange folder 
that is added to the OVO console upon installation of the SPI. 

The setup: The EXSPI Quick Start template group contains templates that are 
easy to install and deploy and require no special customization. Many templates 
in the EXSPI Add-Ons and EXSPI Advanced template groups require a more 
advanced configuration procedure. Before getting started, review template 
requirements in Exspi Template Group Requirements chapter 4  page 5.

Template types: Templates measure collected data against predefined rules, 
generating alarms and messages to assist in problem analysis and resolution. 
Corrective actions are suggested in help text available in the message details.

Within the Exchange group are schedule templates that determine when and 
what metrics are collected; and monitor templates that implement the actual 
metric condition (threshold, object, message text, instructions, etc.) You can 
configure schedule templates to run at exact times, for example, Mondays at 
12:00 noon, according to the managed node’s clock. 

How data collection occurs: When the collection’s scheduled time occurs, the 
Exchange SPI collector/analyzer program is executed and forwards metric 
values to OVO and the HP data collecting agent. At the same time, OVO checks 
predefined threshold settings and triggers alarms when violations occur. 

Where data is stored: The collected data is written to a log file residing on the 
local file system at pre-defined intervals. Error messages are written to the OVO 
Management Server. The Exchange-specific Windows event log messages are 
monitored by the OVO logfile encapsulator.
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How data is displayed: Messages appear in the OVO Message Browser with 
message details containing instruction text to help diagnose and remedy 
problems. If PerfView is present, metric values are available as graphs and if 
Reporter is installed, reports are available.

COMPONENT INTERACTION

The Exchange SPI consists of the following logical components (see the 
following page for a diagram of how the components interact):

� Template Groups with schedule and monitor templates: Monitor templates 
define conditions for each metric, Schedule templates execute metrics 
according to the defined schedule.

� Collector/analyzer program: Collects the metrics specified in the templates at 
predefined intervals, performs calculations, and forwards data to the OVO data 
collecting agent. OVO checks the threshold values and triggers alarms.

� Windows event log: Compares Windows event log entries against predefined 
logfile templates, and forwards error messages to the OVO management 
server.

� EXSPI MBox Config: SPI application that configures an Exchange mailbox 
for SPI to access mailbox and folder information (advanced configuration).

� EXSPI Add DataSource: configures and starts the logging of data, Enable 
Data Logging/Disable Data Logging: starts/stops data logging.

NOTE: This version of the Exchange SPI monitors MS Exchange 2000 and MS 
Exchange 5.5. Template and Template group names contain the version number 
in the prefix, where 60 refers to Exchange 2000 and 55 to Exchange 5.5. For 
example, where an Exchange 5.5 template group has the name EXSPI-55 Event 
Log Errors, the equivalent Exchange 2000 template group is EXSPI-60 Event 
Log Errors. In addition, where templates or template groups are referred to that 
are relevant to both versions, they are referred to in this manual as 
EXSPI-60/55 <template name>.
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Exchange SPI Component Interaction
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EXCHANGE ORGANIZATION

The Exchange organization in an enterprise can be extremely complex, the
following diagram might help in keeping an overview:
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Customization
Customization

Changing template settings:

You can customize the settings on Exchange SPI templates to precisely meet the 
needs of your organization. The following settings can be changed on the 
template record:

� Collection interval
� Threshold
� Message text
� Duration
� Severity
� Actions

Creating new custom templates:

You can create a custom template by copying an original template, making any 
desired changes, and saving it with a new name.

When the OVO environment scales, the Exchange SPI tag feature provides a 
way to partition templates into groups with each group customized in a specific 
manner. 

For more information on customization, see Customizing Exchange SPI chapter 
4  page 15.
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Exchange SPI Reports and Graphs

DATA COLLECTION FOR GRAPHING AND REPORTING

The Exchange SPI collects data for graphing and reporting through data 
collection templates. Exchange and Windows data is collected, summarized, and 
forwarded to the OVO data collecting agent. Reporter can be used to access the 
data source EXSPI and write reports using Seagate Crystal Reports.

Data is collected through the following data collection templates:

Table 1: Quick Start Data Collector Templates

Data Collector 
Name

Scheduled 
Times

 
Metric IDs Table

Dc-SMTP Message 
Volume

Hourly 670: SMTP Server.Messages Sent Total
671: SMTP Server.Messages Received Total
672: SMTP Server.Bytes Sent Total
673: SMTP Server.Bytes Received Total
674: SMTP Server.Message Bytes Sent Total
675: SMTP Server.Message Bytes Received Total
Note: These are running totals since the SMTP 
service started. The Exchange SPI calculates a 
delta value between readings and logs this value to 
show message volume.

EXSPI_MULTI   

Dc-SMTP Message 
Queues

Hourly 50: SMTP Server.Categorizer Queue Length
51: SMTP Server.Local Queue Length
52: SMTP Server.Local Retry Queue Length
53: SMTP Server.Messages Pending Routing
54: SMTP Server.Remote Queue Length
55: SMTP Server.Remote Retry Queue Length

EXSPI_MULTI

Log Data Hourly Writes the EXSPI_SINGLE values to the datastore 
each hour. 

EXSPI_SINGLE 
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Dc-IS Msg 
Delivery Time

Every 10 
minutes 
(0,10,20,30
, 40,50)

For hours: 
6-18 
Weekdays 
only

*This must 
be 
scheduled 
every 10 
mins 
beginning 
at the 0 
minute.

581: MSExchangeIS Mailbox.Average Local 
Delivery Time
582: MSExchangeIS Mailbox.Average 
Delivery Time
583: MSExchangeIS Public.Average Local 
Delivery Time
584: MSExchangeIS Public.Average 
Delivery Time
Note: The average value over all samples 
over all database instances in the hour is 
logged to EXSPI_SINGLE, while the 
average value over all samples is logged per 
instance to EXSPI_MULTI

EXSPI_MULTI 
(for each 
Database 
instance)

EXSPI_SINGLE 
(total over all 
Databases)

Dc-IS Mailbox 
Msg Vol

Hourly

For hours: 
6 - 18 
Weekdays 
only

540: MSExchangeIS Mailbox.Local 
deliveries
541: MSExchangeIS Mailbox.Messages 
Delivered
542: MSExchangeIS Mailbox.Messages Sent
543: MSExchangeIS Mailbox.Messages 
Submitted
544: MSExchangeIS Mailbox.Message 
Recipients Delivered
Note: These are running totals since the 
STORE service started. The Exchange SPI 
calculates a delta value between readings and 
logs this value to show message volume.

EXSPI_MULTI 
(for each 
Database 
instance)

EXSPI_SINGLE 
(total over all 
Databases)

Table 1: Quick Start Data Collector Templates

Data Collector 
Name

Scheduled 
Times

 
Metric IDs Table
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Dc-IS Public Msg 
Vol

Hourly

For hours: 
6-18 
Weekdays 
only

550: MSExchangeIS Public.Messages 
Delivered
551: MSExchangeIS Public.Messages Sent
552: MSExchangeIS Public.Messages 
Submitted
553: MSExchangeIS Public.Message 
Recipients Delivered
Note: These are running totals since the 
STORE service started. The Exchange SPI 
calculates a delta value between readings and 
logs this value to show message volume.

EXSPI_MULTI 
(for each 
Database 
instance)

EXSPI_SINGLE 
(total over all 
Databases)

Dc-MTA & IS 
Queue Lengths

Every 10 
minutes 
(0,10,20,30
,40,50)
For hours: 
6-18 
Weekdays 
only
*This must 
be 
scheduled 
every 10 
mins 
beginning 
at the 0 
minute.

 570: MSExchangeMTA.Work Queue Length 
less MSExchangeMTA.Deferred Delivery 
Msgs
571: MSExchangeIS Mailbox.Send Queue 
Size
572: MSExchangeIS Mailbox.Receive Queue 
Size
573: MSExchangeIS Public.Send Queue Size
574: MSExchangeIS Public.Receive Queue 
Size
Note: The average value over all samples 
over all database instances in the hour is 
logged to EXSPI_SINGLE, while the 
average value over all samples is logged per 
instance to EXSPI_MULTI.

EXSPI_MULTI 
(for each 
Database 
instance)

EXSPI_SINGLE
(total over all 
Databases) 
 
EXSPI_SINGLE 
for MTA work 
Queue Length

Table 1: Quick Start Data Collector Templates

Data Collector 
Name

Scheduled 
Times

 
Metric IDs Table
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 Dc-MTA 
Message Volume

Hourly

For hours: 
6-18 
Weekdays 
only

530: MSExchangeMTA.Inbound Messages 
Total
531: MSExchangeMTA.Outbound Messages 
Total
532: MSExchangeMTA.Total Recipients 
Inbound
533: MSExchangeMTA.Total Recipients 
Outbound
534: MSExchangeMTA.Inbound Bytes Total
535: MSExchangeMTA.Outbound Bytes 
Total
Note: These are running totals since the MTA 
service started. The Exchange SPI calculates 
a delta value between readings and logs this 
value to show message volume.

 
EXSPI_SINGLE

Dc-User 
Connections

Hourly 
For hours: 
7-18 
Weekdays 
only

520: MSExchangeIS.Active User Count
521: MSExchangeIS.User Count
 

 
EXSPI_SINGLE

Table 1: Quick Start Data Collector Templates

Data Collector 
Name

Scheduled 
Times

 
Metric IDs Table
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Table 2: Add-Ons Data Collector Templates

Data Collector 
Name

Scheduled 
Times

 Metric IDs Table

Dc-Chat Data 
Collection

30 minutes 
Weekdays only

837: Microsoft Exchange Chat Service.Clients
838: Microsoft Exchange Chat Service.Channels

EXSPI_MULTI

Dc-ConfTrends 30 minutes

For hours: 7-18
Weekdays only

800: MSExchangeCONF.Active Conferences
808: MSExchangeDcsMgr.Local Conferences
809: MSExchangeDcsMgr.Remote Conferences
810: MSExchangeDcsMgr.Active MCUs

 EXSPI_MULTI 

Dc-MCU 30 minutes
For hours: 7-18
Weekdays only

811: MSExchangeT120.Data Messages Received
812: MSExchangeT120.Data Messages Sent
813: MSExchangeT120.KBytes Received
814: MSExchangeT120.KBytes Sent
Note: These are running totals since the 
Conferencing service started. The Exchange SPI 
calculates a delta value between readings and logs 
this value to show message volume.

EXSPI_MULTI 

Dc-Instant 
Messaging 
Enabled Users

Hourly 843: Number IM enabled users on Server 
542: MSExchangeIS Mailbox.Messages.sent

EXSPI_MULTI

Dc-Instant 
Messaging

Hourly 841: MSExchangeIM Virtual Servers.Current 
Users Online
842: MSExchangeIM Virtual Servers.Current 
Subscriptions
845: MSExchangeIM.Failed Requests/sec
846: MSExchangeIM.Rejected Requests/sec

 EXSPI_MULTI
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Table 3: Advanced Data Collector Templates

Data 
Collector 
Name

Scheduled 
Times

 Metric IDs Table

Dc-Exchange 
Info

 Daily 655: Server 
656: Site
657: Organization

EXSPI_MULTI  

Dc-Mailbox 
Data

Weekly 630: Mailbox size (MB)
631: Number of messages
632: Storage Limit
632: Total number of non-associated messages
634: Last logon date/time
815: Database Instance

EXSPI_MULTI And 
EXSPI_DETAILS

Dc-Mailbox IS 
Sum. Data

Daily 610: Physical DB size (EDB)
611: Number of Mailboxes
612: Number of Messages
613: Logical Size 
614: MSExchangeIS Mailbox.Single

EXSPI_SINGLE

Dc-Public 
Folder Data

Weekly 640: Folder Size
641: Number of Messages

EXSPI_MULTI  

Dc-Public IS 
Sum. Data

Daily 620: Physical DB size (EDB)
621: Number of Folders
622: Number of Messages
623: Logical Size
624: MSExchangeIS Public.Single Instance Ratio

EXSPI_SINGLE  

Dc-TrackLog 
Data

Weekly 660: Email Senders
661: Email Recipients
662: Email Destinations
663: Email Sources

EXSPI_M0660
EXSPI_M0661
EXSPI_M0662
EXSPI_M0663

End to End 
Message Ping

15 minutes 1002: SLA values of:
Met SLA
Almost Met SLA
This schedule not only executes the sending of 
messages it also logs the data to the data store.

EXSPI_M1002 
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EXCHANGE SPI REPORTS

Exchange SPI includes a set of reports available in OpenView Reporter: 
summary reports which show data for all servers, and detail reports which show 
information by system. See EXCHANGE 2000 Report List chapter 5  page 10, 
and EXCHANGE 5.5 Report List chapter 5  page 13, for complete lists of 
Exchange SPI reports.

EXCHANGE SPI GRAPHS

PerfView graphs require that an OpenView Performance Agent (also known as 
MeasureWare Agent) be running on the managed node. You can generate these 
graphs from the Application Bank or by selecting a message within the OVO 
message browser and Perform Action. This displays a graph of the metric 
monitor that generated the message as well as others that may be related to it.

In addition, data from any Exchange SPI server can be graphed using PerfView 
and data from the Exchange SPI OVO data collecting agent DSI logfiles. 

PerfView Graph Generated from Exchange SPI Data
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Chapter 2: User Privileges for Exchange SPI
Introduction
Introduction

For full usage of the Exchange SPI, two user account types are required: the 
Local System Account and the Domain Admin User account with special 
Exchange privileges. This chapter outlines:

� Which templates/applications have user account requirements

� How to create the user account and grant proper access permissions in the 
following environments:

� Exchange 2000 nodes in a Windows 2000 domain
� Exchange 5.5 nodes in a Windows NT domain
� Exchange 5.5 nodes in a Windows 2000 domain
2 - 2
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User Privileges

There are 2 levels of user privilege needed by the Exchange SPI:

1. Local System Account (HP ITO Account)

All templates in the Quick Start group, and some templates in the Add-Ons and 
Advanced groups, run under this type of account. No customization to templates 
is required, only threshold changes if desired.

2. Domain Admin User with special Exchange privileges

TEMPLATES: Some templates in the Add-Ons and most templates in the 
Advanced group run under this type of account:

� EXSPI Add-Ons > EXSPI Transaction Log > EXSPI-60 1d-Transaction 
Log

� EXSPI Add-Ons > EXSPI Transaction Log > EXSPI-60 
15m-Transaction Log

� EXSPI Add-Ons > EXSPI Instant Messaging > EXSPI-60 Dc-Instant 
Messaging Enabled Users

� EXSPI Advanced > EXSPI End to End Message Ping > EXSPI-60/55 
End to End Message Ping. These templates use the mailbox created by 
the Exchange SPI application Mailbox Config.

� EXSPI Advanced > EXSPI Reporter Collection > all templates (for 
Exchange 2000 and Exchange 5.5). These templates use the Mailbox 
created by the application Exchange SPI Mailbox Config, to extract 
information from the public folder and mailbox tables via MAPI 
(Messaging Application Programming Interface).

APPLICATIONS: In addition, the Mailbox Config application requires this 
type of account.
2 - 3
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Creating a User Account with Proper Access 
Permissions

Some templates and applications require a user account for each logon domain 
where Exchange servers reside (see Exspi Template Group Requirements chapter 
4  page 5). This user account enables the Exchange SPI to access information 
from the Exchange database. 

The user account must be created and the access privileges granted. As 
significant configuration differences exist between Exchange 5.5 and Exchange 
2000, and configuration details depend on operating system version, detailed 
instructions for each of the following case scenarios are outlined in the following 
pages:

� Case 1: For Nodes with Exchange 2000 in a Windows 2000 Domain 
(Ex2k/W2k)

� Case 2: For Nodes with Exchange 5.5 in a Windows NT Domain 
(Ex5.5/NT4)

� Case 3: For Nodes with Exchange 5.5 in a Windows 2000 Domain 
(Ex5.5/W2k)
2 - 4
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ENABLE VIEWING OF ADMINISTRATIVE GROUPS FOLDER

To enable viewing the administrative groups folder which is necessary for 
creating the user account:

1. Open the Exchange server Properties

2. Select Display administrative groups.

3. Click Apply and OK.

Exchange Server Properties Dialog
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1: Exchange 2000 nodes in a Windows 2000 
Domain (Ex2k/Win2k)

CREATE USER ACCOUNT (EX2K/WIN2K)

1. Log on to the system that hosts the managed node’s domain.

2. Select Start > Programs > Administrative Applications > Active 
Directory Users and Computers.

3. Expand the Active Directory of Users and Computers and right-click 
Users and select New > User.
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Opening New User dialog

4. In the dialog that appears, enter the new user account name, in this example 
MSXSPI, as the First Name and as the User logon name, click Next.
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New User dialog

5. In the dialog, enter a password for the user account in the Password and 
Confirm Password fields (in this example MSXSPI). Select Password 
Never Expires, and click Next.

6. In the New Object dialog, deselect Create an Exchange mailbox. Click 
Next. In the next dialog complete creating the user by clicking Finish.
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Select Password never expires

The user account has been created.

7. You are now back at the Active Directory Users and Computers dialog. 
In the right pane, right-click on the user just created (MSXSPI) and select 
Properties.
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Deselect Create an Exchange mailbox

8. In the MSXSPI Properties page, select the General tab. Enter “OVO 
Exchange SPI” in the Display name and Description fields.

9. Select the Member Of tab, and click Add.

10. In the Select Group dialog select Domain Admin from the top pane.
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MSXSPI Properties dialog

11. Click Add, then OK.

The new user (in this example MSXSPI) is now a member of the Domain Admin 
group. 

12. Click OK and exit the Active Directory Users and Computer dialog.
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Confirming Membership privileges
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GRANTING EXCHANGE ACCESS PERMISSIONS TO USER 
ACCOUNT (EX2K/WIN2K)

In order for the user account (in this example MSXSPI) to have access to a 
mailbox as well as the Exchange IS Public and Private databases, it must have 
certain Exchange Admin permissions. Use Exchange System Manager to grant 
these.

1. Select Start > Program > Microsoft Exchange > System Manager.

Opening System Manager Properties

2. In the left pane expand the Administrative Groups folder.

3. Expand your <Exchange_server_administrative_group> folder.

4. In the right pane, right-click the server to which you want to grant the user 
account access, and select Properties.
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5. In the Properties dialog, select the Security tab.

6. In the Name box select the user name, in this example MSXSPI.

7. In the Permission box, check both the Receive As and Send As 
permissions check boxes.

Assigning Permissions

8. Uncheck the box Allow inheritable permissions from parent to 
propagate to this object.
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9. Click OK and exit the Exchange System Manager dialog.

10. Repeat this procedure for each targeted Exchange server.

NOTE: At a large Exchange site, it can take several minutes to propagate the new 
Exchange administrator information. If you experience permission problems 
while accessing Exchange databases, enforce the setting of the new Exchange 
Admin account by logging directly onto the affected Exchange server (which is 
not yet replicated) and setting the account manually.
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2: Exchange 5.5 Nodes in a Windows NT 
Domain (Ex5.5/NT4)

CREATE USER ACCOUNT (EX5.5/NT4) 

1. Log on as Domain Administrator of the domain to which the Exchange 
server belongs. 

2. Select Start > Programs > Administrative Tools (common) > User 
Manager for Domain.

3. Select User > New User. In the dialog that appears create a new user as 
follows:

 User Manager dialog 
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NOTE: Remember this password; you will need it later to update applications and 
templates.

 New User dialog 

4. Deselect User Must Change password at Next Logon and select 
Password Never Expires.

Username: MSXSPI

Full Name: OVO Exchange SPI

Description: Exchange SPI for OVO

Password/Confirm Password: *********

This password must be entered but will not be authenticated
later.
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5. Click the Groups button to display the Group Memberships window.

 Group Memberships dialog

6. At the right, from the Not a member of: box select the Domain Admins 
user, click Add, and OK to close the Group Memberships window.

7. To include necessary information, click buttons in the New User window:  

8. Click Add to add this user. (If the Exchange Add Mailbox window is 

Profile: No User Profile should be specified.

Hours: All hours of the day and week should be allowed.

Logon To: All workstations should be specified.

Account: Should never expire/should be Global Account.
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displayed, select Cancel to close it).

9. Click the Close button to close the New User window.

10. From the User Manager menu bar select Templates > User Rights....

 User Manager dialog

11. Check the Show Advanced User Rights checkbox.

12. From the drop-down list select Log on as a service in the Right field
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 Selecting Log on as a service for User Rights.

13. Click the Add button to open the Add Users and Groups window.

14. Click the Show Users button.

15. Select the user account just added (MSXSPI), click Add, then OK.
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 Adding the new User Account

16. Repeat steps 12-15 to add the Profile system performance right.

GRANT EXCHANGE ACCESS PERMISSIONS TO USER 
ACCOUNT (EX5.5/NT4)

In order for the user account (in this example MSXSPI) to have access to a 
mailbox as well as the Exchange IS Public and Private databases, it must have 
Exchange Admin permissions. Use Exchange Administrator to grant these 
permissions at the site level.

1. Select Start > Program > Microsoft Exchange > Microsoft Exchange 
Administrator.
2 - 21



Chapter 2: User Privileges for Exchange SPI
Creating a User Account with Proper Access Permissions
2. For each Exchange site where Advanced templates are to be deployed: 

a. In the left pane within the tree, select <site_name>.

b. From the File menu select Properties.

c. In the Properties window, select the Permission tab and click Add to open the 
Add Users and Groups window.

d. Select the user account previously created (MSXSPI), and click Add.

e. Click OK to add the user, and close the Add Users and Groups window.

f. Verify the user has the role of Admin.
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 Verifying the User role

g. Click OK to save the changes.
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3: Exchange 5.5 Nodes in a Windows 2000 
Domain (Ex5.5/W2k)

CREATE USER ACCOUNT (EX5.5/W2K)

1. Log on to the system that hosts the managed node’s domain.

2. Select Start > Programs > Administrative Tools > Active Directory 
Users and Computers.

3. Expand the Active Directory of Users and Computers, right-click Users, 
and select New > User.
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 Selecting New User dialog

4. In the dialog box that appears, enter the user name just created (in this 
example MSXSPI) as the First Name and as the User logon name.
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 New object dialog

5. In the next window, enter Password/Confirm Password for the user 
account (in this example MSXSPI).

6. Select Password Never Expires. Then click Next
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 Setting User Privileges.

7. In the New Object dialog, deselect Create an Exchange mailbox, and 
click Next.
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 Deselect Create an Exchange Mailbox

8. In the next dialog, complete creating the user by clicking Finish.

9. You are now back at the Active Directory Users and Computers dialog. 
In the right pane, right-click on the user just created (in this example 
MSXSPI) and select Properties.

10. In the MSXSPI Properties page, select the General tab. Enter “Exchange 
SPI for OpenView Operations for Windows” in the Description field.
2 - 28



Chapter 2: User Privileges for Exchange SPI
Creating a User Account with Proper Access Permissions
 Properties dialog

11. Select the Member Of tab. Click Add
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Setting User account privileges

12. In the Select Group dialog select Domain Admins from the top pane. 
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Click Add, then OK.

13. The new user (MSXSPI) is now a member of Domain Admins group. Click 
OK and exit the Active Directory Users and Computer dialog.

 New User with new Membership status
2 - 31



Chapter 2: User Privileges for Exchange SPI
Creating a User Account with Proper Access Permissions
GRANT EXCHANGE ACCESS PERMISSIONS TO USER 
ACCOUNT (EX5.5/W2K)

In order for the user account (in this example MSXSPI) to have access to a 
mailbox as well as the Exchange IS Public and Private databases, it must have 
certain Exchange Admin permissions. Use Exchange Administrator to grant 
these permissions at the site level.

1. Select Start > Program > Microsoft Exchange > Microsoft Exchange 
Administrator.

2. For each Exchange site where Advanced templates are to be deployed:

a.. In the left pane within the tree, select <site_name>.

b. From the File menu select Properties.

c. In the Properties window, select the Permission tab and click Add to open the 
Add Users and Groups window.

d. Select the user account previously created (in this example MSXSPI), and click 
Add.

e. Click OK to add the user, and close the Add Users and Groups window.

f. Verify the user has the role of Admin.
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 Verifying User roles.

g. Click OK to save the changes.
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Introduction
Introduction

This chapter offers instructions for installing, configuring and removing 
Exchange SPI components. It covers the following topics:

� Installing and configuring the Exchange SPI

� Template Groups: installation considerations

� Installation and Basic Configuration

� Advanced Configuration

� Removing the Exchange SPI

� Deleting Exchange SPI Templates
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Prior to Installation

� This release is targeted at OVO for UNIX 6.0 or higher. Please verify 
your current OVO version.

� Before installing this version of the Exchange SPI (A.03.30), any 
previous version of the Exchange SPI must be removed.

� Every installation of the Exchange SPI requires a basic configuration 
procedure which is detailed in the Installation and Basic Configuration 
chapter 3 page 6 section.

� A more advanced configuration procedure is required before deploying 
some of the Add-Ons and Advanced templates, for example those for 
collecting Exchange folder and mailbox information, and testing 
connections between pairs of servers. See Advanced Configuration 
chapter 3 page 12 for the advanced configuration procedures.

� Some templates require a domain admin account with special Exchange 
privileges. See Exspi Template Group Requirements chapter 4 page 5 
for template requirements, and see Creating a User Account with 
Proper Access Permissions chapter 2 page 4 for procedures for creating 
this type of account.

� Exchange SPI requires a data collection agent - OpenView Performance 
Agent [also known as MeasureWare Agent] or OpenView Operations 
subagent [included with OpenView Operations 7.0], to collect data for 
reporting and graphing purposes. Use the Exchange SPI application 
EXSPI Add DataSource to configure the data source and start logging 
data.

� Exchange SPI reports require HP OpenView Reporter. Exchange SPI 
graphs require HP OpenView PerfView.
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TEMPLATE GROUPS: INSTALLATION CONSIDERATIONS

After installation, you can view the Exchange SPI templates using the 
Templates→Reload Templates command in the Message Source Templates 
window. 

Exchange SPI templates are located under the SPI for MS Exchange group and 
can be deployed as groups or individually. The groups are as follows:

� SPI for MS Exchange: under this folder are the version specific 
folders Exchange 5.5 and Exchange 2000. All the version specific 
template groups can be seen under each of these folders. In general, the 
requirements for each group are as follows: 

• SPI for MS Exchange Quick Start templates, in general require 
the HP ITO Account, see Exspi Template Group Requirements 
chapter 4 page 5.

• EXSPI Add-Ons templates group are designed to monitor specific 
software components, which may or may not be installed on the MS 
Exchange Server (for example, Lotus Notes must be installed for the 
EXSPI-60 Lotus Notes Connector templates to work). 
Consequently, you individually select templates for the software 
components you are using on the targeted MS Exchange Server.

• EXSPI Advanced templates and EXSPI Add-Ons generally 
require a Domain Admin account (MSXSPI). See Creating a User 
Account with Proper Access Permissions chapter 2 page 4 for 
details.

All data collection templates require that a data collection agent (the OV 
Performance or OVO subagent) be installed and running on the managed node. 
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EXCHANGE USER ACCOUNT REQUIREMENTS

Some of the templates and/or applications require a domain admin user account 
with special Exchange privileges. For information on which templates require 
this type of account, see Exspi Template Group Requirements chapter 4 page 5. 
For procedures to create this type of account, see Creating a User Account with 
Proper Access Permissions chapter 2 page 4.
3 - 5



Chapter 3: Installing & Configuring the Exchange SPI
Installation and Basic Configuration
Installation and Basic Configuration

The Basic Exchange SPI configuration is designed to get you started quickly by 
using the Quick Start group or individual templates that require only the HP ITO 
Account as a beginning basis for server monitoring. Many of the templates in the 
Add-Ons and Advanced template groups require an Exchange Domain Server 
Account (MSXSPI), and a more Advanced configuration procedure which is 
covered later in this chapter. 

When finished with the basic installation and configuration procedure, you will 
have completed the following tasks: 

� Task 1: Install Exchange SPI on the management server.

� Task 2: Install OVO agents on all MS Exchange server systems (required 
if the OVO Windows agent is not yet deployed).

� Task 3: Configure the OVO Message Browser.

� Task 4: Distribute Exchange SPI actions, commands, monitors to the 
Exchange servers. 

� Task 5: Configure data sources.

� Task 6: Assign and distribute template groups to managed node(s) running 
MS Exchange server.

TASK 1: INSTALL EXCHANGE SPI ON THE MANAGEMENT 
SERVER

Prerequisite: OpenView Operations (OVO) management server must be 
installed. It is not necessary to stop OVO sessions before beginning the 
Exchange SPI installation.

NOTE: The instructions that follow show the command line usage of swinstall. For 
HP-UX systems you can also use the graphical user interface (GUI), but the 
procedure is not covered here.
3 - 6



Chapter 3: Installing & Configuring the Exchange SPI
Installation and Basic Configuration
The Exchange SPI is available on the HP OPenView Operations for UNIX 
Applications CD-ROM. There are two CDs in the Applications CD-ROM set, the 
first contains the products’ management server install packages, and the second 
contains the OpenView Reporter and OpenView Performance Manager 
integrations for the applications. At this point use the first CD.

For an HP-UX 10.20 management server, enter:

swinstall -s /cdrom/OV_DEPOT/10.OHPUX.sdtape EXSPI

For an HP-UX 11.0 management server, enter:

swinstall -s /cdrom/OV_DEPOT/11.OHPUX.sdtape EXSPI

For a Solaris management server, enter:

swinstall -s /cdrom/OV_DEPOT/SOLARIS.sdtape EXSPI

TASK 2: INSTALL OVO AGENTS ON MS EXCHANGE 
SERVERS

Install an OVO Windows agent on all MS Exchange servers. (If you need details 
for installing the OVO agent, refer to the OVO Installation Guide for the 
Management Server.) 

TASK 3: CONFIGURE THE OVO MESSAGE BROWSER 

All target hosts for Exchange SPI must be OVO managed nodes and must be 
running on an OVO 6.0 intelligent agent. 

1. Log on to OVO as the OVO administrator (opc_adm).

2. Select Window > User Bank
a. Select the opc_adm user
b. Choose Actions > User > Modify
c. Press the Responsibilities button and use the Responsibilities for Operator 
(opc_adm) window to view messages.
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The Configure Administrator Message Browser Window

3. In the Node Group that contains your Exchange managed node, select the 
following Exchange SPI message groups:

� EXSPI

� EX_Fault

� EX_Perf

4. Use the Actions > Browser > Start/Reload from the OVO User Bank menu.

TASK 4: DISTRIBUTE EXCHANGE SPI ACTIONS, 
COMMANDS, MONITORS

To collect Exchange data, you must complete the following steps:

1. Distribute Exchange SPI actions, commands, monitors to the Exchange 
servers by selecting Actions>Agents>Install/Update SW & Config from the 
OVO Node Bank menu. 

2. In the Install/Update OVO Software and Configuration window check the 
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following checkboxes to select components:

� Actions

� Monitors

� Commands

3. Check the Nodes in List Requiring Update checkbox.

4. Check the Force Update checkbox.

5. If a node was not selected previously, select the node in the Node Bank and 
use Get Map Selections to add the Exchange server(s) to the target node(s) 
list.

6. Click OK.

7. The following message is displayed in the message browser:

The following configuration information was successfully 
distributed: Actions, Commands, Monitors

TASK 5: CONFIGURE/UPDATE DATA COLLECTION AGENT 
DATASOURCES

The OVO data collection agent collects, logs, and timestamps data from 
individual systems. If you use OV Performance Agent (MeasureWare Agent), 
you can use PerfView to graph the data; if you use OpenView Reporter, you can 
use it to generate reports displayed as Web pages.

1. At the OVO console, from the Window menu, select Application 
Bank>EXSPI Admin. 

2. To create data sources for the OVO data collection agent, run EXSPI Add 
DataSource for each managed node.
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TASK 6: ASSIGN/DISTRIBUTE EXCHANGE SPI TEMPLATES

The following section covers the assignment and distribution of templates to the 
managed nodes.

1. Open the OVO Node Bank.

2. Select the desired managed node(s) designated to run Exchange SPI.

3. To assign (select) the templates for distribution, select 
Actions>Agents>Assign Templates from the menu bar.

4. In the Define Configuration window select Add.

5. In the Add Configuration window select Open Template Window....

6. In the Message Source Templates window double-click the SPI for MS 
Exchange group to display the subgroups.

7. Select, and double-click Exchange 2000. 

8. Select the desired EXSPI template group or individual template(s).

9. Click Get Template Selections from the Add Configuration window.

10. Click OK from the Add Configuration window.

11. Click OK from the Define Configuration window.

The desired templates have been selected for distribution. Next, distribute 
them to the managed nodes.

12. To distribute the assigned templates, select Actions >Agents>Install/Update 
SW & Config from the Node Bank menu. 

13. In the Install/Update OVO Software and Configuration window check the 
Templates checkbox to select it.

14. Check the Nodes in List and the Force Update checkboxes.
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15. If a node was not selected previously, select the node in the node bank and 
click Get Map Selections to list the target node(s), then click OK to 
distribute templates to the managed node(s).

16. The following message is displayed in the message browser:

The following configuration information was successfully 
distributed: Templates

The Exchange SPI templates are distributed to the selected managed 
node(s). Exchange SPI monitors will begin running.

You have now completed the standard Exchange SPI installation and 
configuration process. 
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Advanced Configuration

Prerequisite: Complete tasks in the Installation and Basic Configuration 
chapter 3 page 6 section.

Advanced configuration covers the deployment of templates that require a 
Domain Admin account with special Exchange privileges. When finished, you 
will have completed the following tasks:

� Task 1: Create an Exchange SPI user account (MSXSPI). 

� Task 2: Grant Exchange Access permissions to the user account.

� Task 3: Configure user account on managed nodes.

� Task 4: Enable message tracking.

� Task 5: For each Exchange server create the MSXSPI<host_name> 
mailbox.

� Task 6: Configure MS Exchange servers for End to End Message Ping.

� Task 7: Assign/distribute templates.

TASK 1: CREATE AN EXCHANGE SPI USER ACCOUNT

A Domain Admin user account is needed for each Windows logon domain where 
your managed Exchange servers reside. See the procedures in Creating a User 
Account with Proper Access Permissions chapter 2 page 4 for details on creating 
this type of account in the various combinations of Exchange/Windows 
environments.

TASK 2: GRANT EXCHANGE ACCESS PERMISSIONS TO 
USER ACCOUNT

See the procedures in User Privileges chapter 2 page 3, where the procedures for 
granting proper access permissions for each combination of Exchange/Windows 
environment is outlined.
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TASK 3: CONFIGURE MANAGED NODES

1. Select all Exchange managed nodes. 

2. Drag these nodes and drop them on the EXSPI Node Config application 
located in the EXSPI Admin application group. 

3. When prompted, enter the domain, user and password for the user account 
(created in Task 1: Create an Exchange SPI User account chapter 3 page 
12). NOTE: When you run this application, be sure to enter the correct 
domain name, user and password. This domain is not the DNS domain 
name but the NT domain name. 

NOTE: If Exchange nodes are managed at a later date, perform this procedure for all 
newly managed Exchange nodes.

TASK 4: ENABLE MESSAGE TRACKING

Set message tracking on servers so that all messages that are routed through a 
server are added to the message tracking logs. You can record information about 
the sender, the message, and the recipient. If you need to log more detailed 
information, you can also record the subject line of the e-mail message.

The procedure for enabling message tracking on Exchange 5.5 and Exchange 
2000 servers, is outlined in Enabling Message Tracking chapter 4 page 10.

TASK 5: CONFIGURE MAILBOXES

In addition to the MSXSPI user, a mailbox is required for accessing mailbox and 
folder information, necessary for End to End Message Ping and Reporter 
Collection templates. Use the Exchange SPI application MBOX Config (located 
in the EXSPI Admin application group) to create the mailbox:

1. Modify the MBOX Config application in order to run it as MSXSPI. 
(Change the Execute as User field, add MSXSPI and password.) 

2. Run the EXSPI MBOX Config application to configure mailboxes for the 
Exchange servers (you can select multiple nodes simultaneously).
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For each Exchange server a mailbox is created with the prefix MSXSPI and 
Windows hostname. For an Exchange 5.5 server, EXSPI MBOX Config 
application creates a mailbox MSXSPI<host_name> for the primary Windows 
account MSXSPI. For an Exchange 2000 server, it creates the mailbox 
MSXSPI<host_name> for account MSXSPI<host_name> (which it also 
creates.)

For example, for the node rosspi4.rose.hp.com (Internet name) and Windows 
name ROSSPI4 a mailbox is created called MSXSPIROSSPI4. 

NOTE: In order to create a different mailbox with a different name, see the procedure 
Changing the Mailbox Name chapter 4 page 27.
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NOTE:
If you receive an error in the above step or you cannot automatically create 
mailboxes, you must manually complete the following on each Exchange 
server:

� For each Exchange server create a mailbox with the prefix MSXSPI 
and Windows hostname.

� For Exchange 5.5, create this mailbox with primary Windows 
account MSXSPI. 

� For Exchange 2000, create this mailbox with primary Windows 
account MSXSPIROSSPI4 (this must first be created).

TASK 6: SET UP END TO END MESSAGE PING SERVER 
CONNECTIONS AND ALARMS 

To measure the round trip time required for a message to travel from one server 
to another and then back to the originating server, you can use the EXSPI-60/55 
End to End Message Ping template group. Before you can use the templates, you 
must configure the pair of servers that you want to test. 

To configure the servers, complete the following steps:

1. Run the EXSPI Ping Config application on the OVO management server. 

The EXSPI Ping Config application opens a default file as follows: 

#Src-Svr:Src-MB:Dest-Svr:Dest-Site:Dest-MB:Timeout:MetSLA
:
AlmostMetSLA

[Entry Descriptions]
# Src-Svr=Source Server (required) 
# Src-MB=Source Mailbox (optional). 
# Defaults to"MSXSPI<host_name>". 
# Dest-Svr= Destination Server #(optional) - 
# Required only for SMTP systems.
# Dest-Site=Destination Site (not used/reserved for 
future use)
# Almost always NOT required. 
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# Dest-MB= Destination Mailbox (required)    
# Timeout= Timeout (required) 
# (s-seconds, m-minutes, h-hours) 
# MetSLA= Met SLA time (required for reports) 
# (s-seconds, m-minutes, h-hours) 
# AlmostMetSLA = Almost met SLA time (require for reports) 
# (s-seconds, m-minutes, h-hours)

#Examples:
#EXCH1::::MSXSPIEXCH2:25m:1m:1m
#EXCH1:MAILBOXEXCH1:::MAILOXEXCH3:2h:5m:2m
#EXCH2:MAILBOXEXCH2:::MAILOXEXCH4:1h:20m:10m
#EXCH3:MSXSPIEXCH3:EXCH4.AM.HP.COM::MSXSPIEXCH4:25m:5m:5m

2. Enter information about the servers to replace each entry separated by a 
colon (:). 

� Source Server - The server that the ping originates from. Each 
server where EX-SPI is distributed has the same file, so the EX-SPI 
collector/analyzer will parse this file and use all lines where the 
Source Server matches the server where it is run from.

� Source Mailbox (optional) - The mailbox to send the mail from. If 
this is not included, a default account is used 
“MSXSPI<host_name>” where <host_name> is replaced with the 
name of the server.

� Destination Server (optional) - The destination server, used only 
for SMTP systems, is necessary only when the site directory does 
not contain the destination mailbox. In this case, SMTP is used and 
the fie ld would contain the SMTP server name (the server 
following the "@"; for example, the entry for mailbox 
"brendan_belcastro@am.exch.hp.com", would contain 
"am.exch.hp.com." 

� Destination Site (currently not used) - The destination site is 
needed only in the rare case where the destination mailbox is not 
unique. In such a situation, the entry contains the MS Exchange site 
to send the message to. It is currently not used and is reserved for 
future functionality. 
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� Destination Mailbox (required) -The mailbox to send the ping to. 
This field is usually the only required destination entry.

� Timeout (required) (s-seconds, m-minutes, h-hours): - If a sent 
message does not return in the defined timeout interval, EXSPI logs 
it as a failure and sends a message to OVO. Failed messages are 
tallied in terms of count and percentage within a report. The 
timeout value must be larger than the values for MetSLA and 
AlmostMetSLA so that a returned message can be processed using 
these values. It may have Exceeded SLA even though it has not 
exceeded the timeout interval. A Failed/Timedout message occurs, 
therefore, only when the message never returns and the timeout 
period is exceeded.

NOTE The minimum timeout value should be set slightly less than the collection 
interval. For example, if the collection interval for metric 1002 is 30 minutes 
(the default), the timeout should be set to at least 25 minutes. The logic is that 
because the next measurement occurs only every 30 minutes, you should allow 
up to that amount of time for any messages to return before "giving up" and 
generating a failure. If you keep the timeout value within the collection interval 
and the reply message does return, it can be processed as Met, Almost Met or 
Exceeded as opposed to Failed/Timedout.

� MetSLA (required for reports) (s-seconds, m-minutes, h-hours) -   
If the round trip time is greater than this value, the message is 
logged as either Almost Met SLA or Exceeded SLA. This value is 
required if data is being sent to MeasureWare Agent DSI for 
reporting (-l option when running exspi_e2k.exe or exspi_e55.exe). 
It is optional if only using alarms.

� AlmostMetSLA (required for reports) (s-seconds, m-minutes, 
h-hours) - If the round trip time is greater than the MetSLA value 
but less than or equal to MetSLA plus AlmostMetSLA, the message 
is logged as Almost Met SLA. Otherwise, when the round trip time 
is higher than MetSLA plus AlmostMetSLA, it is logged as Clearly 
Exceeded SLA. This parameter is required if data is being logged to 
MeasureWare Agent DSI (-l option when running exspi_e2k.exe or 
exspi_e55.exe), optional if only using alarms.
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NOTE Timeout, MetSLA, and AlmostMetSLA values can have optional identifiers that 
denote the measurement units the value represents; for example, 4m (4 minutes) 
30s (30 seconds) or 1h (1 hour). The default unit is seconds; for example, the 
entry 4 is recognized as 4 seconds.

Examples:

EXCH1::::MSXSPIEXCH2:25m:1m:1m - 
Use the default FROM mailbox of MSXSPIEXCH1. Message must return within 
1 minute to meet the SLA, 2 minutes to almost meet the SLA, and at over 25 
minutes generates a failure/timeout.

EXCH1:MAILBOXEXCH1:::MAILOXEXCH3:2h:5m:2m - 
Message must return within 5 minutes to meet the SLA, 7 minutes to almost 
meet the SLA, and at over 2 hours generates a failure/timeout.

EXCH2:MAILBOXEXCH2:::MAILOXEXCH4:1h:20m:10m - 
Message must return within 5 minutes to meet the SLA, 7 minutes to almost 
meet the SLA and at over 2 hours generates a failure/timeout.

EXCH3:MSXSPIEXCH3:EXCH4.AM.HP.COM::MSXSPIEXCH4:25m:5m - 
This represents a server/mailbox that is not located in the site's directory and will 
use SMTP to communicate with the EXCH4 server. Message must return within 
5 minutes to meet the SLA, 10 minutes to almost meet the SLA, and at over 25 
minutes generates a failure/timeout.

WHERE DATA IS NOT BEING LOGGED: MODIFY SCHEDULE 
TEMPLATE

Before you deploy the EXSPI-60/55 End to End Message Ping template group 
you need to modify the schedule template in the group to prevent errors from 
occurring. 

Modify the Schedule template as follows:

1. Select Window>Message Source Template

2.  Double-click the EXSPI-60/55 End To End Message Ping template 
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group.

3. Select the EXSPI-60/55 End To End Message Ping Schedule template.

4. Press the Modify button and in the Command line box, delete the -l 
parameter.

SET UP DIFFERENT CONDITIONS/ THRESHOLDS FOR 
DIFFERENT SERVER PAIRS
   USING OVO OBJECT FIELD & ALARMING 

   (OVO High Level Expertise Recommended)

Alarms can be set to occur with metric EXSPI-60 1002 (Ping). Because you may 
need to set different thresholds for multiple server pairs, the following examples 
are offered. The examples show the syntax to insert in the template Conditions, 
using the OVO object pattern fields so that you can set differing thresholds. 
Metric 1002 sends the "FromMailbox,ToMailbox" in the object pattern fields 
with the following definitions:

FromMailbox = FromServer:FromMailbox
ToMailbox    = [ToServer]:ToMailbox
where [ToServer] is optional

Config Entry Object

EXCH1:MSXSPIEXCH2:25m:1m:1m EXCH1:MSXSPIEXCH1,:MSXSPIEXCH2

EXCH1:MAILBOXEXCH1:
MAILOXEXCH3:2h:5m:2m

EXCH1:MAILBOXEXCH1,:MAILOXEXC
H3

EXCH2:MAILBOXEXCH2:
MAILOXEXCH4:1h:20m:10m

EXCH2:MAILBOXEXCH2,:MAILOXEXC
H4

EXCH3:MSXSPIEXCH3:EXCH4.AM.HP.COM
:
MSXSPIEXCH4:25m:5m:5m

EXCH3:MSXSPIEXCH3,EXCH4.AM.HP.C
OM:
MSXSPIEXCH4
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For example:

TASK 7: ASSIGN/DISTRIBUTE ADVANCED/ADD-ONS 
TEMPLATES

After completing the advanced configuration steps, you can assign and distribute 
templates from the EXSPI Advanced and Add-On template groups to the 
managed node(s) running MS Exchange server.

ConditionName & 
Type

Condition Object Pattern Threshold Explanation

EXSPI-60 1002.1

+Message on 
Matched Condition

EXCH1:MSXSPIEXCH1,:
MSXSPIEXCH2

120 Threshold condition for 
ping between System 
EXCH1 and mailbox 
MSXSPIEXCH2 on 
system EXCH2. Object 
pattern is case 
sensitive.

EXSPI-60 1002.2
+Message on 
MatchedCondition

EXCH1:MSXSPIEXCH1,:
MSXSPIEXCH3

240 Threshold condition for 
ping between System 
EXCH1 and mailbox 
MSXSPIEXCH3 on 
system EXCH3. Object 
pattern is case 
sensitive.

EXSPI-60 1002.3
-Suppress
Matched Condition

EXCH1:MSXSPIEXCH1,:
MSXSPIEXCH2

EXCH1:MSXSPIEXCH1,
:MSXSPIEXCH3

If the threshold was not 
exceeded for these two 
system pairs, you must 
suppress the message if 
either of these system 
pairs gets past 1002.1 
or 1002.2.

EXSPI-60 1002.4
+Message on
Matched Condition

60 A blank object pattern 
to catch all remaining 
system pairs.
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The EXSPI Advanced template groups contain two logfile templates which 
capture Exchange warning and information events. Because Exchange generates 
numerous warning and information events, you might want to assign these 
templates only for troubleshooting Exchange: 

� Logfile EXSPI-60/55 Exchange Information

� Logfile EXSPI-60/55 Exchange Warnings

1. Open the OVO Node Bank and select the desired managed node(s) 
designated to run Exchange SPI.

2. Select Actions>Agents>Assign Templates from the menu bar.

3. In the Define Configuration window select Add.

4. In the Add Configuration window choose Open Template Window....

5. In the Message Source Templates double-click SPI for MS Exchange 
group to display the subgroups.

6. Select templates from the EXSPI Advanced template group for the correct 
Exchange version.

7. Select Get Template Selections from the Add Configuration window and 
click OK from the Add Configuration window and click OK from the 
Define Configuration window.

Distribute templates that have been assigned/selected for distribution to the 
managed nodes:

8. Select Actions: Agents>Install/Update SW & Config from the menu bar. 

9. In the Install/Update OVO Software and Configuration window check the 
Templates checkbox to select it.

10. Check the Nodes in List and the Force Update checkboxes.
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11. If you did not select a node previously, choose Get Map Selections to list 
the target node(s).

12. Click OK to distribute templates to the managed node(s).

The following message appears in the Message Browser:

The following configuration information was successfully 
distributed: Templates

You have now completed the advanced configuration installation process. The 
Exchange SPI is ready to use.
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How to Remove Exchange SPI

This process completely removes the Exchange SPI installation from the OVO 
management server, including all Exchange SPI templates. Any customized 
templates or copies of Exchange SPI default templates residing in other OVO 
template groups should also be removed. Follow these steps in order to ensure a 
proper removal.

REMOVING EXCHANGE SPI SOFTWARE FROM THE 
MANAGEMENT SERVER

NOTE: The swremove program removes the files from the file system only. The 
Exchange SPI templates are still in the OVO data repository and must be 
deleted manually. First, however, they (and the Exchange SPI software) must be 
deassigned from the managed nodes.

1. Open a terminal window and log on as root.

2. In the teminal window run swremove by entering:
/usr/sbin/swremove EXSPI

DE-ASSIGNING EXCHANGE SPI TEMPLATES FROM 
MANAGED NODES

1. Open the OVO Node Bank.

2. To deassign the templates from the node, select Actions>Agents>Assign 
Templates from the menu bar.

3. In the Define Configuration window select all Exchange SPI templates or 
template groups, including any user-customized templates.

4. Click Remove Templates.

5. Click OK.
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REMOVING EXCHANGE SPI FROM MANAGED NODES

1. Select Actions: Agents>Install/Update SW & Config from the menu bar.

2. Check the following checkboxes to select these components for removal:

� Templates

� Actions

� Monitors

� Commands

3. Click the Nodes in List Requiring Update button.

4. If you did not select a node previously, click the Get Map Selections button 
to list the target node(s).

5. Click the Force Update button.

6. Click OK. The following message appears in the message browser:

The following configuration information was successfully 
distributed:

Templates Actions Commands Monitors

The Exchange SPI templates and software have now been removed from the 
selected managed node(s). The Exchange SPI templates still reside in the OVO 
data repository and must be deleted manually. Continue with Deleting Exchange 
SPI Templates chapter 3  page 25.
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Deleting Exchange SPI Templates

You must delete Exchange SPI templates manually. These include the Message 
Source, Message Group, and Application Group templates. To speed the process, 
select a number of templates at one time by pressing the SHIFT key as you select 
the first and last template in a list. 

1. To delete the Exchange SPI Message Source templates, select Window: 
Message Source Templates from the menu bar.

2. Open all Exchange SPI template groups and use SHIFT+click to select all 
templates for deletion.

3. Select Delete from All to delete the templates.

4. Click Yes to the message: Do you really want to delete the 
template(s)?

5. To delete the EXSPI messages group, from the menu bar select 
Window>Message Group Bank.

6. Select the EXSPI messages group.

7. From the menu bar select Actions>Message>Delete.

8. Click Yes to the message: Do you really want to delete the 
message groups? 

9. To delete the Exchange SPI application groups and their contents, select 
Window: Application Bank from the menu bar.

10. Select all Exchange EXSPI Admin Applications and Graphs.

11. From the menu bar select Action>Application>Delete.

12. Click Yes to the message: Do you really want to delete the 
application groups.
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Introduction

Like all HP OpenView SMART Plug-Ins, the Exchange SPI is easy to use. This 
chapter describes some special usage features and functionality, including:

� Daily Tasks

� Exchange SPI template group requirements

� Changing the OpenView data collection agent setup

� Enabling Message Tracking

� Additional Monitoring Tools

� Command Line Parameters

� Customizing the Exchange SPI

� Basic Customization procedures
� Advanced Customization procedures

� Reinstalling Exchange SPI Templates
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Daily Tasks

A daily task list for monitoring with the Exchange SPI follows:

1. Use the OVO message browser to watch for warning and critical messages 
or multiple alarms. Read the associated instruction text.

2. Adjust alarm thresholds if too many alarms are being generated (see 
“Customize the Threshold” later in this chapter).

3. Use the OVO graphing and reporting applications to drill down for 
additional information, or to view history or trends.

4. Check the active Message Browser frequently. Note the message group a 
metric belongs to:

� EXSPI. Messages generated by EX-SPI programs.They contain 
instruction text to help to diagnose/remedy problems.

� EX_Perf. Messages regarding performance.

� EX_Fault. Messages regarding error conditions.

5. Click Perform Action (if available) from the message or message 
browser to automatically perform a pre-defined operator action. Click 
Details from the message or message browser to view details of the set 
action.
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6. Click Instructions from the message browser or the message itself to 
read and follow suggested instructions to help diagnose/remedy problems 
(see example below).

Sample Instruction Text from Exchange SPI Alarm Message

7. Use MeasureWare Agent to export data if desired. Consult the 
MeasureWare Agent User’s Guide for details.
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Exspi Template Group Requirements

NOTE: Important Microsoft Information on the Web: Before you deploy Exchange SPI 
templates, please refer to the Microsoft article “PRB: Performance Object Is 
Not Displayed in Performance Monitor” at this URL: 
http://support.microsoft.com/support/kb/articles/Q248/9/93.ASP. The
article contains information on editing the Windows registry so that
performance objects (tracked by Performance Monitor) are always enabled.
A disabled performance object could cause an Exchange SPI template to fail.
By following the instructions in the article, you can ensure that templates
are able to collect Exchange performance data as expected. 

Some templates in the SPI for Exchange template groups require that particular 
software components/services are installed on Exchange server systems before 
the deployed templates will work, and some require the existence of a domain 
admin account with special Exchange privileges. To create such an account, see 
Creating a User Account with Proper Access Permissions chapter 2  page 4.

Use the following tables to decide which templates you want to install. In the 
template prerequisites table you can see whether or not a template 
group/subgroup works with Exchange 5.5 and/or Exchange 2000, as well as any 
required configuration. Template Group Descriptions show you what type of 
data/functionality the template group offers.
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Table 1: EXSPI Template Group Prerequisites for Exchange 5.5  
EXCHANGE 5.5

Template Group/ Subgroup

Required 
Exchange 
Service

Required Manual Configuration

EXSPI-55 Quick Start N/A N/A

EXSPI-55 Add-Ons

EXSPI cc:Mail Connector

cc:Mail
Connector

N/A

EXSPI Internet Mail Services Internet Mail
Service (IMS)

N/A

EXSPI Lotus Notes Connector Lotus Notes
Connector

N/A

EXSPI News Service N/A N/A

EXSPI-55 Advanced

EXSPI End to End Message Ping

Create MSXSPI User account
with correct permissions

Edit the MBOX Config
Application to contain User
Password

Create mailbox using MBOX
Config application

Configure EXSPI End to End
Message Ping template to set up
server pairs

Modify the template to include
user account and password

EXSPI Event Log Warnings &
Information

Use for troubleshooting

EXSPI Reporter Collection Create MSXSPI User account and
password
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Table 2: EXSPI Template Group Prerequisites for Exchange 2000
EXCHANGE 2000

Template Group/ Subgroup

Required 
Exchange 
Service

Required Manual Configuration

EXSPI-60 Quick Start 

All templates

N/A N/A

EXSPI-60 Add-Ons

EXSPI cc:Mail Connector

cc:Mail 
Connector

N/A

EXSPI Chat Service Exchange Chat 
Service

N/A

EXSPI Conferencing Service Exchange 
Conferencing 
Server

N/A

EXSPI MCU Server MCU Server N/A

EXSPI Instant Messaging Exchange Instant 
Messaging 
Service

Some templates in this group must 
be modified to contain a domain 
admin user and password

EXSPI Lotus Notes Connector Lotus Notes 
Connector

N/A

EXSPI NNTP Network News 
Transfer 
Protocol (NNTP)

N/A

Transaction Log Some templates in this group must 
be modified to contain a domain 
admin user and password
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EXSPI-60 Advanced

EXSPI End to End Message Ping

N/A For each node where the template is 
to be deployed:

Create MSXSPI User account with 
correct permissions

Edit the MBOX Config application 
to contain User Password

Create mailbox using MBOX 
Config application

Configure EXSPI End to End 
Message Ping template to set up 
server pairs

Modify the template to include user 
account and password

EXSPI Event Log Warnings & 
Information

N/A Use for troubleshooting

EXSPI Reporter Collection N/A Create MSXSPI User account and 
password

EXCHANGE 2000

Template Group/ Subgroup

Required 
Exchange 
Service

Required Manual Configuration
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Changing the Data Collection Agent Setup

The HP OpenView Exchange SPI can detect whether or not you are using 
OpenView Performance Agent (also known as MeasureWare Agent). If you are, 
your new Exchange SPI installation will automatically use it as well. As a result, 
if you use PerfView, your new installation also supports that configuration. 

If for any reason you decide that you want to use the new HP OpenView 
subagent included with OVO 7.0, you can configure managed nodes to do so. 
Note that this configuration does not support PerfView. 

To override the use of OpenView Performance Agent, set up an empty file 
named nocoda.opt and store it on the managed node in a specific location. The 
location will vary according to the managed node operating system as shown 
below.

To create the File: 

1. (If necessary) on the managed node according to the path shown in the 
preceding table, create the dsi2ddf directory. 

2. Use a text editor to open a new file.

3. Save the file as nocoda.opt in the managed node’s dis2ddf directory

Managed Node O/S  File Location

HP-UX and Solaris /var/opt/OV/conf/dsi2ddf/nocoda.opt

Windows \usr\ov\conf\dsi2ddf\nocoda.opt
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Enabling Message Tracking

Set message tracking only on servers. All messages that are routed through a 
server are added to the message tracking logs. This information is collected by 
the EXSPI-60/55 Dc-TrackLog Data collection templates.You can record 
information about the sender, the message, and the recipient. If you need to log 
more detailed information, you can also record the subject line of the e-mail 
message.

To enable message tracking on Exchange Server 2000:

1. Start System Manager: On the Start menu, point to Programs > Microsoft 
Exchange > System Manager. 

2. In the console tree, double-click Server, right-click a server and select 
Properties.

3. On the General tab, check Enable message tracking to log information 
about the sender, the time the message was sent or received, the message 
size and priority, or the message recipients. 

4. To record the subject of any message sent to, from, or through the server, 
check Enable subject logging.

5. Repeat steps 3 and 4 for each server.

To enable message tracking on Exchange Server 5.5:

1. Select Start > Programs > Microsoft Exchange > Microsoft Exchange 
Administrator.

2. Expand the site level and Configuration to view selections beneath it.

3. In the details pane double-click Information Store Site Configuration.

4. In the Information Store Site Configuration Properties dialog, check 
Enable message tracking, and select OK.
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 Information Store Site Configuration dialog 

5. Repeat steps 3 and 4 for MTA Site Configuration.
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 MTA Site Configuration dialog 

6.  In the left pane select Connections.

7. In the right pane select Internet Mail Service, check the Enable message 
tracking checkbox, and click OK.

If the Internet Mail Service connector does not exist, skip the
following steps.
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Additional Monitoring Tools

The Exchange SPI provides a number of predefined graphs that can be generated 
from the OVO Application Bank by selecting a graph from the group EXSPI 
Graphs.

OVO also provides Windows applications in the Application Bank group 
Windows Tools useful for performing maintenance and troubleshooting. Virtual 
Terminal (PC) is a particularly useful application which provides a “telnet” style 
login to Windows systems. 

The Performance group also contains PerfView-related applications. Use “Start 
PerfView” to launch PerfView (the OVO agent must be installed and running on 
the Management Server). Consult the OVO Administrator's Reference for a 
detailed description of these applications.

Command Line Parameters

The collector/analyzer executable exspi_e2k.exe can be used with the following 
command line parameters:

Parameter Description

-m <metric range> -m (metric range) is used to specify the metric 
number or range of metric numbers.

-t <tag> -t (tag) allows the collector/analyzer to use a 
different set of templates than those originally 
provided with the Exchange SPI when collecting 
metrics.

NOTE: Additional information about the tag 
feature is found at the end of the “Customizing 
Exchange SPI” section.

-p -m <range> [-v] -p (print) executes specified metrics and prints their 
values to standard output, for example:

<exspi_e2k.exe or exspi_e55.exe> -p -m 1-1001
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-a -a directs the collector/analyzer to send the metric 
value to OVO for alarm generating

-s -s executes the collector as the Domain Admin 
account (MSXSPI). Requires completion of the 
advanced configuration (see Advanced 
Configuration chapter 3  page 12).

-l -m <metric range> 

-x <extended_option> 

Data collection metrics start at 0500. Types:

Value: logs the actual value

Delta: logs the difference between current and 
previous

Average: logs the average over a specific interval 
(e.g. 1h)

where:

-l collector logs data to logfile instead of reporting it 
to OVO

-x <extended_option> is one of: 

  logtype: is either "value, delta, or avg"

  logfreq: can only be "hourly" and is used only  
with "avg"

  runfreq: tells the collector the interval in seconds. 
If the schedule interval of EXSPI is every 10 
minutes, the runfreq option must be set to 10*60 = 
600: -x runfreq=600. The runfreq option can only be 
used with "avg."

  mbox: followed by "=<mailbox_name>" allows 
specification of certain mailboxes with certain 
metrics, specifically metrics:

611,612,622,623,630,631,632,640 and 641 

Example of a command line using this option:  
exspi -p -m 611 -x mbox=obrab

Parameter Description
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Customizing Exchange SPI

CHOOSING METRIC TO MONITOR

Before beginning customization, first decide which metrics can remain without 
changing the thresholds, (see “Exchange SPI Metric Specifications” later in this 
chapter or the Exchange SPI Reference Manual).

NOTE It is recommended that you make a copy of the original template group and use 
the copy for customization purposes 
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Basic Customization 

CREATING CUSTOM GROUPINGS

Create custom template groups as follows:

1. Log onto OVO as the OVO Administrator.

2. Select Window>Message Source Templates.

3. In the Message Source Templates window select the desired template group 
and click the Add... button (if Add Logfile... is displayed, pull down the 
list and select Add Group) and select a name and description for this group.

4. To copy templates to the new group:

� In the Message Source Templates window, double-click to open the 
group containing the desired templates.

� Select the templates to copy and choose Edit>Copy from the Message 
Source Templates menu to copy the templates.

� Return to the newly created template group and choose Edit>Paste 
from the menu.

Creating a New Template Group
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MODIFYING MESSAGE GENERATION 

Alarms are generated with Reset, without Reset or Continuously. 
To change the Metric Generation Type (usually in conjunction with the 
Threshold, Polling Interval and Reset value) follow these steps:

1. Select the Message Source Templates window.

2. Double-click to open the template group containing the metric to modify.

3. Click the Modify button. 
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Modifying Message Generation

4. Select one of the Message Generation types:

� with Reset: Alarms are generated after the monitoring threshold has 
been exceeded. No additional alarms are generated until metrics drop 
below a specified Reset threshold and subsequently exceed the 
monitoring threshold.

� without Reset: Alarms are generated after the monitoring threshold has 
been exceeded. No additional alarms are generated until metrics drop 
below the threshold and subsequently exceed it.

� Continuous: Alarms are generated continuously when metrics exceed 
the threshold.
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MODIFYING METRIC TEMPLATE CONDITIONS

Modify metric attributes as follows.

1. Select the Message Source Templates window.

2. Double-click the template group containing the metric to modify.

3. Double-click the desired metric

4. In the Message and Suppress Conditions window select the condition to 
modify and click the Modify button.
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The Message and Suppress Conditions Window
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Condition Dialog

The Condition window is displayed. The following attributes can be 
easily modified:

Threshold. Set the desired threshold.

Reset. This is a limit under which the object's value must drop (or exceed for 
minimum thresholds) to return the alarm state of the object to normal. 
After an object's alarm state has returned to normal, a new message can 
be issued if the monitored parameter again exceeds (or drops below for 
minimum thresholds) the threshold value. Do not enter a value if you do 
not wish to impose a reset limit. Note that you can enter a reset value 
greater than the threshold value (or less for minimum threshold types), 
which has the same effect as if you don't specify a reset value.
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Duration. Most metrics are defined as Message Generate type without 
Reset and without a Duration. Please consult the OVO Concepts 
Guide or on-line Help prior to modifying this field.

Severity. Click the [Severity] button and select the desired severity 
setting.

Message Text. Be careful not to modify any of the parameters in a message. 
Parameters are surrounded by <> brackets and begin with $.

Actions. This field provides the ability to add custom programs. Two types 
of actions are available: 

�Operator initiated: These actions are only performed upon the 
initiation of an operator.

�Automatic: These actions are performed automatically when the 
metric alarms.

NOTE Some metrics have an operator-initiated action which will display a graph if 
PerfView is installed on the management server.

Customizing the Threshold

Customize the threshold as needed. To do so, copy the existing condition to use 
as the default, and modify the original condition to serve as the exception. 
Follow these steps:

1. Double-click the metric you want to customize (for example, 
EXSPI-60-0001). 

1. In the Message and Suppress Conditions window select the desired 
condition and select the Copy button to make a copy of the condition. 

2. Enter a name for the condition; for example, EXSPI-60-0001.3.

3. Click OK to close EXSPI-60-0001.3. This will be the default condition.
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4. Select the original condition, EXSPI-60-0001.1.

5. Click the Modify button to display the Condition window.

6. In the Object Pattern field, enter the desired characters to use for pattern 
matching (see the OVO on-line help or the OVO Administrators Task Guide 
for pattern matching syntax).

7. Click the Test Pattern Matching… button to test the pattern and verify 
pattern matching (you must set up a match file first).

8. Change the value in the value in the Threshold field.

Testing Pattern Matching from the Condition Window
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Customizing Schedules

Schedule templates define the schedule by which the collector/analyzer will 
gather metric information. To modify a schedule template, follow these steps:

1. Select Window>Message Source Templates and double-click the template 
group containing the template to modify.

2. Double-click the desired template

3. In the Modify Scheduled Actions change any of the schedule information 
or other parameters. For more information on this, see Enabling Message 
Tracking chapter 4  page 10. 

4. Click OK to close and save the changes.

5. Deploy the template to the desired managed node(s).
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Customizing a Schedule Template
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The Tag Feature

When servers are dedicated to specific sites or business units, you may find it 
more effective if those servers do not all share the same set of Exchange SPI 
templates. In such cases, the tag feature is useful in allowing you to change 
existing templates and rename them. In this way you can associate template 
assignments with specific servers and the areas with which they are associated. 
For example, you might create a business administration group of templates and 
tag those templates with “ADM-” or a branch office group and tag those with 
“BR-.”

The tag feature allows you to create custom templates in a quick way. To 
summarize the steps, you:

� Make copies of existing monitor templates that you want to modify. 
� (optional) Modify the monitor template settings. 
� Save each modified template under the same name with a prefix.
� Enter each metric and - <prefix tag> after the collector/analyzer 

command in the Program Monitor or MIB ID box of the schedule 
template.

Using this method allows the collector/analyzer to recognize a set of templates 
different from those originally provided with the Exchange SPI. This method 
allows you to enlarge the single set of templates to adjust to differing conditions 
among the servers you use.

To use this feature, make copies of the original Exchange SPI templates. The 
names you give these new templates must contain a prefix with the original 
template name. To tell the collector/ analyzer to use this new template rather than 
the original template, specify the tag option on the schedule template command 
line.

New collector templates can also be created in this way, for example:

exspi_e2k -m 16 -t ADM-

In this case the new collector template is called "ADM-EXSPI-15min."
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Advanced Customization

Changing the Windows User Account Name

The MSXSPI Windows user account used for accessing Exchange folder and 
mailbox information, is referenced in several applications. To change the 
account name, edit the EXSPI Mbox Config application and change the user 
name setting.

Changing the Mailbox Name

For all schedule templates in the template group EXSPI-60 Data Collection 
(Adv), add -x <mailbox_name> to the command which is executed under the 
schedule. For example: 

exspi_e2k -l-s -m 630,631,632 -x logtype=value -x 
mbox=MSXSPI

The default mailbox MSXSPI <hostname> can be changed by supplying the 
mailbox name to EXSPI MBOX Config:

Use the OVO Customized Startup to start EXSPI MBOX Config, and add 
-x mbox=<mailbox_name> to the Application Parameter box.

NOTE Do not add the domain before the user name. The user must be in the domain 
where the Exchange Server is located, and cannot be a local user.
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Re-installing Exchange SPI Templates

To re-install all templates with original factory settings, run the following 
command:

/opt/OV/bin/OpC/opccfgupld -verbose -replace 
/var/opt/OV/share/tmp/OpC_appl/EXSPI/exspiset

CAUTION Any customization of the original templates will be overwritten.
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Introduction
Introduction

This chapter describes how to install and generate reports within Reporter from 
Exchange SPI data. It contains the following components:

� Installing Exchange SPI Reports

� Exchange SPI Reports template requirements

� Exchange SPI Report List

� Using Exchange SPI Reports and Graphs

� Deploying the Quick Start data collection templates
� Deploying Reporter Collection templates
� Exchange SPI graphs
� Deinstalling Exchange SPI Reporter templates
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Installing Exchange SPI Report Templates

 To install Reporter reports on the system where Reporter is installed:

1. Double-click EXSPI-Reporter.msi on the HP OpenView Operations for 
Unix Application CD-ROM.

2. In the Setup Type dialog of the InstallShield Wizard, select the Complete 
setup type, and click Next.

3. EXSPI-Reporter is now installed, click Finish to exit the wizard.
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4. Open Reporter to see the SPI for Exchange folder under Reports.

5. Open the SPI for Exchange group of reports, and see the list of groupings of 
Exchange reports. As you select each group, see in the details pane the 
individual reports available in that group.
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TEMPLATES TO DEPLOY FOR EXCHANGE SPI REPORTS 

Exchange SPI reports display data collected from EXSPI templates deployed to 
Exchange servers. 

In the table that follows, the location is relative to the folders SPI for Exchange \ 
Exchange 5.5 AND Exchange 2000. Some templates are specific to the version 
of Exchange, when this is the case the location is also specific to this version. 
Reports that are designated Exchange 2000 contain information relevant to 
Exchange 2000 only. All other reports are relevant to both versions of Exchange. 

The specific templates required for OVO to generate particular reports are as 
follows:

Report Name

(SUMMARY For 
All Systems)

Template Name Metric ID 
Logged

Location

Exchange 2000    
System 
Information 
Summary 

Dc-Mailbox IS Sum. Data 
Dc-Public IS Sum.Data 
Dc-Exchange Info

 610-611, 614, 
620-621, 
623-624, 656

EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange 2000 
Top 100 
Mailboxes
   

Dc-Mailbox Data  
630,632,633,634 
815

Exchange 2000
\EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange SLA 
Message Delivery 
   

 End to End Message Ping 1002 EXSPI Advanced 
\EXSPI End to End 
Message Ping

Exchange System 
Information 
Summary

Dc-Private/Mailbox IS 
Sum. Data
Dc-Public IS Sum. Data
Dc-Exchange Info

610-611, 614,
620-621, 
623,624, 656

EXSPI Advanced 
\EXSPI Reporter 
Collection
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Exchange Top 100 
Mailboxes
 
  

Dc-Mailbox Data  630-632 Exchange 5.5
\EXSPI Advanced
\EXSPI Reporter 
Collection

Exchange Top 100 
Public Folders
    

Dc-Public Folder Data 640, 641 EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange 
Messaging Trends 
for all Servers 

Dc-MTA Message 
Volume

 530-535 EXSPI Quick Start 
\EXSPI Message Transfer 
Agent

Dc-IS Private MsgVol OR

Dc-IS Mailbox Msg Vol
Dc-IS Public Msg Vol

540-543
550-552

EXSPI Quick Start 
\EXSPI Information Store

Dc-IMS Message Volume 590-591  Exchange 5.5
\EXSPI Add-Ons 
\EXSPI Internet Mail 
Services

Dc-SMTP Message 
Volume
  

670-675 Exchange 2000
\EXSPI Add-Ons 
\EXSPI SMTP 

Report Name

(SUMMARY For 
All Systems)

Template Name Metric ID 
Logged

Location

Report Name

(DETAIL-shows 
data grouped by 
single systems)

Template Name Metric ID 
Logged

Location

Exchange 2000 
Chat Trends 
  

EXSPI-6.0 Dc-Chat 
Service Clients and 
Channels.data

 837-838 Exchange 2000
\EXSPI Add-Ons
\EXSPI Chat Service

Exchange 2000 
Conferencing 
Trends

EXSPI-6.0 
Dc-ConfTrends.data

 800, 810, 809, 
808

Exchange 2000
\EXSPI Add-Ons 
\EXSPI Conferencing 
Service
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Exchange 2000 
MCU Trends
   

EXSPI-6.0 Dc-MCU 811-814 Exchange 2000
\EXSPI Add-Ons 
\EXSPI Conferencing 
Service

Exchange 2000 
Instant Messaging 
Users growth

EXSPI-6.0 1d-Dc-Instant 
Messaging

 843 Exchange 2000
\EXSPI Add-Ons 
\EXSPI Instant 
Messaging

Exchange 2000 
Instant Messaging 
Availability and 
Usage Trends 

EXSPI-6.0 1hr-Dc-Instant 
Messaging DC

 841, 845 Exchange 2000
\EXSPI Add-Ons 
\EXSPI Instant 
Messaging

Exchange 2000 
Inactive 
Mailboxes
       

EXSPI 6.0 Dc-Mailbox 
Data

 603,633,634, 
815

Exchange 2000
\EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange 2000 
Mailbox Details
    

EXSPI 6.0 Dc-Mailbox 
Data

 
630-632,634,815

Exchange 2000
\EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange 2000 
Mailbox Summary
    

EXSPI 6.0 Dc-Mailbox IS 
Sum. Data
EXSPI 6.0 Dc-Mailbox 
Data

610-613, 624, 
630-632, 815

Exchange 2000
\EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange 2000 
Mailbox Usage 
Trends
 

 EXSPI-6.0 Dc-Mailbox 
IS Sum. Data

 610-613  Exchange 2000
\EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange User 
Connections
 

 Dc-User Connections
 

 520-521 EXSPI Quick Start
\EXSPI Services and 
Processes

Exchange Folder 
Summary

Dc-Public IS Sum. Data
Dc-Public Folder Data

620-624, 
640-641

 \EXSPI Advanced 
EXSPI Reporter 
Collection

Report Name

(DETAIL-shows 
data grouped by 
single systems)

Template Name Metric ID 
Logged

Location
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Exchange Folder 
Usage Trends

Dc-Public IS Sum. Data  620-622  \EXSPI Advanced 
EXSPI Reporter 
Collection

Exchange IMS 
Messaging Trends
   

EXSPI-5.5 Dc-IMS 
Message Volume

 590-593 Exchange 5.5
\EXSPI Add-Ons 
\EXSPI Internet Mail 
Services

Exchange 
Mailbox Details

Dc-Mailbox Data 630-632  \EXSPI Advanced 
EXSPI Reporter 
Collection

Exchange 
Mailbox Summary
 

Dc-Private/Mailbox IS 
Sum. Data
Dc-Mailbox Data

 610-613, 
630-632

 \EXSPI Advanced 
EXSPI Reporter 
Collection

Exchange 
Mailbox Usage 
Trends

Dc-Private/Mailbox IS 
Sum. Data

610-612  \EXSPI Advanced 
EXSPI Reporter 
Collection

Exchange 
Messaging Trends 

Dc-MTA Message 
Volume

530-535 EXSPI Quick Start 
\EXSPI Message Transfer 
Agent

Dc-IS Private Msg Vol 
OR
Dc-IS Mailbox Msg Vol
Dc-IS Public Msg Vol

540-543
550-552

EXSPI Quick Start 
\EXSPI Information Store

Dc-SMTP Message 
Volume

 670-675  Exchange 2000
\EXSPI Quick Start 
\EXSPI General Data 
Collection

Exchange Top 
Destinations
   

Dc-TrackLog Data  662 EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange Top 
Recipients
    

Dc-TrackLog Data  661 EXSPI Advanced 
\EXSPI Reporter 
Collection

Report Name

(DETAIL-shows 
data grouped by 
single systems)

Template Name Metric ID 
Logged

Location
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Exchange Top 
Senders
   

Dc-TrackLog Data  660 EXSPI Advanced 
\EXSPI Reporter 
Collection

Exchange Top 
Sources
   

Dc-TrackLog Data  663 EXSPI Advanced 
\EXSPI Reporter 
Collection

Report Name

(DETAIL-shows 
data grouped by 
single systems)

Template Name Metric ID 
Logged

Location
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EXCHANGE 2000 Report List

DETAIL REPORTS EXCHANGE 2000

Detail reports provide information by system. One report is generated with a 
section for each system. The content of each report is as follows:

� Exchange 2000 Inactive Mailboxes: This report lists all the mailboxes 
on the server that have not been accessed. The report also lists 
mailboxes that have not been accessed in 20, 40 and 60 or more days.

� Exchange User Connections: Provides a trend graph showing open 
and active user connections for the selected Exchange server.

� Exchange Folder Summary: Provides summary information about the 
public folders on the server.

� Exchange 2000 Mailbox Details: Provides detailed information about 
the mailboxes on the server including summary totals, size distribution, 
and top mail users.

� Exchange 2000 Mailbox Summary: Provides summary information 
about the mailboxes on the server including summary totals, size 
distribution, and top mail users.

� Exchange Top Destinations: Identifies the top e-mail destinations 
(local, other Exchange sites, internet, gateway) for e-mail being sent by 
an Exchange server.

� Exchange Top Recipients: Identifies the top recipients of e-mail for an 
Exchange server.

� Exchange Top Senders: Identifies the top senders of e-mail for an 
Exchange server. Only e-mail sent by users that have Exchange 
mailboxes is counted. E-mail sent by clients such as Netscape and 
UNIX that do not have a corresponding Exchange mailbox are not 
counted. 
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� Exchange Top Sources: Identifies the top e-mail sources (local, other 
Exchange sites, internet, gateway) for e-mail being received by an 
Exchange server.

� Exchange Folder Usage Trends: Contains graphs showing trends in 
database size, number of messages and average size of public folders. 
The trends are shown for the time period selected when the report is 
generated.

� Exchange IMS Messaging Trends: Provides trend graphs showing 
messaging volume for the Internet Mail Service.

� Exchange 2000 Mailbox Usage Trends: Contains graphs showing 
trends in database size, number of messages, and average size of 
mailboxes. The trends are associated per storage group and are shown 
for the time period selected when the report is generated.

� Exchange Messaging Trends: Provides trend graphs showing 
messaging volume for the Message Transfer Agent, Information Store 
and SMTP server message volume.

� Exchange 2000 Chat Trends: Provides averaged information on the 
number of client chat connections and channels for hours of the day 
over the time period indicated.

� Exchange 2000 Conferencing Trends: Provides averaged information 
on the number of conferences and active MCUs for hours of the day 
over the time period indicated.

� Exchange 2000 MCU Trends: Provides averaged information on the 
number of conferences and active MCU's for hours of the day over the 
time period indicated.

� Exchange 2000 Instant Messaging Users growth: Shows the number 
of users that are Instant Messaging enabled over the time period 
indicated. 

� Exchange 2000 Instant Messaging Availability and Usage Trends: 
Shows instant messaging usage trends.
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SUMMARY REPORTS EXCHANGE 2000

Summary reports show data for ALL servers. The content of each report is as 
follows:

� Exchange Messaging Trends for All Servers: Provides trend graphs 
showing messaging volume for the Message Transfer Agent, the 
Information Store, the Internet Mail Service across all Exchange 
servers, and the SMTP server messaging volume.

� Exchange Message Delivery SLA (Service Level Agreement): 
Provides a trend graph showing how message delivery, messages read, 
and directory read service levels are being met across all monitored 
connections.

� Exchange 2000 System Information Summary: Contains summary 
information about the OS and Exchange versions, mailboxes and public 
folders.

� Exchange 2000 Top 100 Mailboxes: Lists the top 100 mailboxes by 
disk space usage across all mailbox databases.

� Exchange Top 100 Public Folders: Lists the top 100 public folders by 
disk space usage.
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EXCHANGE 5.5 Report List

DETAIL REPORTS EXCHANGE 5.5

Detail reports provide information by system. One report is generated with a 
section for each system. The content of each report is as follows:

� Exchange User Connections: Provides a trend graph showing open 
and active user connections for the selected Exchange server.

� Exchange Folder Summary: Provides summary information about the 
public folders on the server.

� Exchange Mailbox Summary: Provides summary information about 
the mailboxes on the server including summary totals, size distribution, 
and top mail users.

� Exchange Top Destinations: Identifies the top e-mail destinations 
(local, other Exchange sites, internet, gateway) for e-mail being sent by 
an Exchange server.

� Exchange Top Recipients: Identifies the top recipients of e-mail for an 
Exchange server.

� Exchange Top Senders: Identifies the top senders of e-mail for an 
Exchange server. Only e-mail sent by users that have Exchange 
mailboxes is counted. E-mail sent by clients such as Netscape and 
UNIX that do not have a corresponding Exchange mailbox are not 
counted. 

� Exchange Top Sources: Identifies the top e-mail sources (local, other 
Exchange sites, internet, gateway) for e-mail being received by an 
Exchange server.

� Exchange Folder Usage Trends: Contains graphs showing trends in 
database size, number of messages and average size of public folders. 
The trends are shown for the time period selected when the report is 
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generated.

� Exchange IMS Messaging Trends: Provides trend graphs showing 
messaging volume for the Internet Mail Service.

� Exchange Mailbox Usage Trends: Contains graphs showing trends in 
database size, number of messages, and average size of mailboxes. The 
trends are shown for the time period selected when the report is 
generated.

� Exchange Messaging Trends: Provides trend graphs showing 
messaging volume for the Message Transfer Agent, Information Store 
and SMTP server message volume.

SUMMARY REPORTS EXCHANGE 5.5

Summary reports show data for ALL servers. The content of each report is as 
follows:

� Exchange Messaging Trends for All Servers: Provides trend graphs 
showing messaging volume for the Message Transfer Agent, the 
Information Store, the Internet Mail Service across all Exchange 
servers, and the SMTP server messaging volume.

� Exchange Message Delivery SLA (Service Level Agreement): 
Provides a trend graph showing how message delivery, messages read, 
and directory read service levels are being met across all monitored 
connections.

� Exchange Top 100 Mailboxes: Lists the top 100 mailboxes by disk 
space usage.

� Exchange Top 100 Public Folders: Lists the top 100 public folders by 
disk space usage.
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Using Exchange SPI Reports and Graphs

Exchange SPI report and graph generation require that you complete the
following:

• Deploy the Quick Start template group for data collection templates.

• Configure and deploy Exchange SPI reporter collection templates.

NOTE: Time Interval for Exchange SPI Reports or Graphs

Exchange SPI reports and graphs will not be available until data has
been gathered to the management server from the managed nodes. This
occurs each night, so at least one day of activity is needed for the reports
to populate. Where a report or graph type requires data from a Sat/Sun
collection, those reports/graphs will require a weekend to pass.

Deploying the Quick Start Template Group
In order to collect data for reports and graphs the General Data
Collection templates in the Quick Start template group need to be
deployed.

To deploy the templates:

1 Locate the General Data Collector templates in the Quick Start template
group for the correct Exchange version.

2 Select all the templates in this group in the details pane.

3 Right click, select All Tasks > Deploy on....

4 Select the nodes the templates should be deployed on.

5 Confirm the selection with OK.
5 - 15



Chapter 5: Integrating Exchange SPI with Reporter
Using Exchange SPI Reports and Graphs
Configure/Deploy Reporter Collection Tem-
plates 

For any Exchange server system on which you would like to receive reports, you 
need to deploy Exchange SPI templates from the EXSPI Advanced > EXSPI 
Reporter Collection group.

To configure the Reporter Collection templates two steps are required:

1. Enable message tracking. This is a version specific procedure.

2. Deploy Reporter Collection templates.

1. ENABLE MESSAGE TRACKING

Exchange provides a message-tracking facility that stores processed 
message information in a log file. Template EXSPI-60/55 Dc-TrackLog 
Data collection template reads the log file created by enabling message 
tracking. This template must be deployed to the appropriate managed nodes 
to gather the information. For procedures outlining how to enable message 
tracking on Exchange 5.5 and Exchange 2000 servers, see Enabling
Message Tracking chapter 4 page 10.

2. DEPLOY REPORTER COLLECTION TEMPLATES

1. In the OVO Manager console expand the Template management > 
Template groups folders to view template groups.

2. Open SPI for Exchange > Exchange 5.5 or Exchange 2000 > EXSPI 
Advanced to view the template groups in the EXSPI Advanced folder.

3. In the EXSPI Advanced folder double-click the Reporter Collection 
template sub-group. 

4. In the details pane where all the templates are now listed, select the 
templates, right-click, and select Deploy on....
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5. In the Deploy templates on... dialog, select all nodes by checking Nodes, 
or select individual nodes by clicking the adjacent check box.
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Exchange SPI Graphs

Exchange SPI comes with a set of preconfigured PerfView graphs. They are 
located on the OVO console tree in the Operations Manager > Reports and 
Graphs > Graphs > SPI for Exchange folder. These graphs require that 
OpenView PerfAgent (aka MW Agent) be running on the managed node, see 
Exchange SPI Graphs chapter 1 page 15.

Exchange SPI graphs show Exchange 5.5 and Exchange 2000 data and are 
organized in the following categories:

INFORMATION STORE 

Users: This graph shows information store user count metrics for the current 
day.

Delivery: This graph shows hourly metrics for the average delivery times of 
messages to Exchange Server private and public mailboxes.

Transaction Log Disk Space: This graph shows Transaction Log Disk Space 
usage on the Exchange Server.

MESSAGING

Queues: This graph show Exchange Server queue lengths. 

Newsfeed Volume: This graph shows Exchange Server newsfeed volume. 

MTA Volume: This graph shows Exchange Server Message Transfer Agent 
volume. 

Internet Mail Volume: This graph shows Exchange Server Internet Mail 
Connector volume. 

Internet Mail Queue: This graph shows the Exchange Server Internet Mail 
Service queue count. 
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SMTP Volume: This graph show SMTP Volume on the Exchange Server. 

SMTP Queues: This graph shows SMTP Server queues on the Exchange Server.

MAILBOX DATABASE

Private Mailbox Volume: This graph shows Exchange Server Private Mailbox 
volume.

Mailbox Usage: This graph shows Exchange Server Mailbox usage.

PUBLIC FOLDER DATABASE

Public Folder Usage: This graph shows Exchange Server Public Folder usage.

Public Folder Database: This graph shows Exchange Server Public Folder 
volume.
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Generating Graphs from an Exchange SPI DSI 
Logfile
PerfView graphs require an OVO agent to be running on the management server. 
You can generate PerfView graphs from the OVO Application Bank or by 
pressing Perform Actions in the OVO message details window or in the OVO 
message browser. The graph represents the metric data that generated the 
message as well as other metric data related to it.

In addition, data from any Exchange SPI server can be graphed using PerfView 
and data from Exchange SPI MeasureWare DSI logfiles. 

Simple instructions for generating the graph follow. Additional information on 
using PerfView can be obtained from the PerfView User Guide.

1. Open a terminal window and log on.

2. In the terminal window, to verify that the DISPLAY environment variable is 
set to your terminal window, enter:

echo $DISPLAY

If the DISPLAY environment variable is not set correctly, set it to your 
terminal window.

3. To start PerfView, type:

pv

The main PerfView window is displayed.

NOTE Since values are logged hourly to MeasureWare, use the PerfView Graph: 
Settings->Points Every to set the time setting to 1h or 3h.
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4. Select Data Sources>Manage.

5. In the PerfView Systems window highlight the desired system from the list 
and click Open.

The Data Sources window is displayed listing all known source files. If the 
desired data source is not listed, press Select and enter the data source name.

6. Select the desired source file from the list and click Open.

Perfview connects to the data source and displays it in the main window.

7. Select Graphs>Create New Graph.

8. In the Select Metrics window highlight the data source file.

A list of metrics is displayed to use for graphing.

9. Highlight the desired metrics from the list to use for graphing.

The selected metrics are displayed in the Metrics to Be Graphed portion of 
the Select Metrics window.

10. Click OK when finished selecting metrics.

11. Click Draw to generate the graph.

12. You can use the Settings menu on the PerfView Graph window to change 
settings for the graph, the Show menu to drill down to examine points on 
the graph, and the File menu to save, print, or export the graph. You can 
also correlate operating system metrics with Exchange SPI metrics.
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Deinstalling Exchange SPI Report Templates

Remove the Exchange SPI reports with the InstallShield Wizard:

1. Open the EXSPI-Reporter InstallShieldWizard.

2. Click Next on the Welcome wizard screen.

3. Select Remove, then click Next.

4. Confirm the next screen by clicking Remove.

5. The InstallShield Wizard has deinstalled EXSPI-Reporter. Click Finish.
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Introduction

This chapter offers troubleshooting suggestions for Exchange SPI. It includes the 
following sections:

� Verifying Software Installation on the Management Server

� The Exchange SPI Error Log

� Turning on Tracing

� Common Errors

� Verifying the MSXSPI account has the right privileges 

� Verifying MeasureWare Integration

� Installing Old DSI Log Files

� Advanced Configuration Template Failures
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Verifying Exchange SPI Installation on the 
Management Server

NOTE: This utility is not available for Sun Solaris.

1. To check the integrity of Exchange SPI files on the OVO management 
server, run the following command: /usr/sbin/swverify EXSPI

This command produces output similar to the following:

swverify.agent_auto_exit = false
swverify.agent_timeout_minutes = 10000
swverify.allow_incompatible = false
swverify.allow_multiple_versions = false
swverify.autoremove_job = false
swverify.autoselect_dependencies = true
swverify.check_contents = true
swverify.check_permissions = true
swverify.check_requisites = true
swverify.check_scripts = true
swverify.check_volatile = false
swverify.control_lang = C
swverify.enforce_dependencies = true
swverify.follow_controller = false
swverify.log_msgid = 0
swverify.logdetail = false
swverify.logfile = /var/adm/sw/swverify.log
swverify.loglevel = 1
swverify.mount_all_filesystems = true
swverify.rpc_binding_info = {
ncacn_ip_tcp:[2121]
ncadg_ip_udp:[2121]
}
swverify.rpc_timeout = 5
swverify.select_local = true
swverify.target_directory = /var/spool/sw
swverify.verbose = 1
swverify.software = EXSPI
swverify.targets = /
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The Exchange SPI Error Log

Errors are forwarded to the browser and logged to:

\usr\OV\exspi\log\exspierror

For example:

04/01/02 08:43:57 ERROR exspi(488) [colamain.cpp:333]: 
EXSPI-60-40:
Exchange Server Software not installed on this system 
(Check: SOFTWARE\Microsoft\Exchange\Setup). Unable to 
perform collection!
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Turning on Tracing

If a problem occurs and you are asked to turn on tracing by the EX-SPI support 
team, follow these steps:

1. Open or create the following file:

\usr\OV\exspi\defaults

2. If TRACE OFF is a statement in the file, change it to TRACE ON, 
otherwise add the words TRACE ON to the end of the file. The next 
execution of exspi_e2k.exe or exspi_e55.exe will read this file, and log 
trace statements to:

\usr\OV\exspi\log\trace

NOTE The trace file will grow very large. It is advisable to leave tracing enabled only 
long enough to recreate the problem or in order to comply with HP support 
instructions.
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Common Errors

1. When re-installing or upgrading Exchange Server, Exchange Setup program 
shows errors.

Symptom: Exchange Server re-install or upgrade (e.g., new Service Pack), 
the Exchange Setup generates error messages about DLLs that can't be 
overwritten.

Solution: Stop OVO (opcagt -stop) and MeasureWare (mwacmd 
stop), then retry the operation.

2. Schedule template fails with message:
EXSPI xxxxx Metric Collection failed.

Symptom: The scheduled command failed with an exit code other than 0.

Solution: This error sometimes occur if the system is rebooted just before 
the collector/analyzer program was executed. 

However, if this is not the case do the following: To find out more 
information about the failure, modify the failing schedule template, check 
the Send Output of Action check box and re-distribute templates again.

The browser message should now contain an annotation with more 
information about the failure. Also, check the exspierror for more 
information.
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Verifying MSXSPI account has right 
privileges

In order to verify that you have created the MSXSPI account with the right 
amount of privileges to run advanced metrics such as 5, 841, or 630, do the 
following:

1. Log into your Exchange 2000 server as MSXSPI user (in the correct NT 
domain).

2. Open a DOS command prompt window.

3. cd to the directory where exspi collector is located (typically in 
c:\usr\OV\bin\OpC\monitor)

4. Run the following series of commands:

exspi_e2k.exe  -m 5   -p

exspi_e2k.exe  -m 841   -p

exspi_e2k.exe  -m 630   -p

5. These will print the results to the screen.

6. If these executed properly and the correct results printed on the screen, your 
MSXSPI account has the right permissions.
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Verifying MeasureWare Integration

To verify MeasureWare integration check the following:

1. Is the MeasureWare Agent installed on the Exchange server managed node?

2. Is the MeasureWare agent up and running (mwacmd status or 
MeasureWare Agent application in RPM Tools Windows group)? There 
should be TWO rep_server programs running. If not, re-start 
MeasureWare Agent.

3. Verify MeasureWare Agent configuration.

� Verify that perflbd.mwc (e.g., in \rpmtools\data) contains EXSPI 
data source.

� If not, re-run MW setup: First run, Disable Data Logging, wait for 
MW to re-start, then run Enable Data Logging.

� Verify that DSI logfiles were created 
in\usr\exspi\dsi\log\exspi_log.EXSPI_*

� Check the timestamps of those files; they are updated when the data 
collectors run.

4. Verify exspi_e2k.exe  or exspi_e55.exe data forwarding to 
MeasureWare.

� The collector/analyzer exspi_e2k.exe or exspi_e55.exe 
specified in the schedule templates writes MeasureWare data to 
\usr\exspi\dsi\*.dat only if the keyword MW ON is present in the 
\usr\exspi\defaults file (note, the defaults file has no file 
extension.). Check the defaults file for the above keyword. If not 
present, run EXSPI Add DataSource.

� Check whether *.dat files are present in \usr\exspi\dsi.
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� Check timestamps of *.dat files.

Advanced Configuration Template Failures

Symptom: The following data collectors fail and a critical message is 
shown in the OVO browser:

� EXSPI-60/55 Dc-Private IS Sum. Data

� EXSPI-60/55 Dc-Public IS Sum. Data

� EXSPI-60/55 Dc-Mailbox Data

� EXSPI-60/55 Dc-Public Folder Data

Solution: These collectors access Exchange directly and require MSXSPI 
user and MSXSPI<hostname> mailbox.

Verify MSXSPI user, MSXSPI<hostname> mailbox, MSXSPI rights in 
Exchange and MeasureWare:

1. Verify MSXSPI user setup.

� Use Windows User Manager to verify MSXSPI account. The user must 
exist in the same domain as the Exchange Server is part of. Note: there 
must be no local MSXSPI user.

� MSXSPI user must be part of Domain Admin group.

2. Verify MSXSPI rights in Exchange.

The MSXSPI user must have "Receive As" and "Send As" Exchange 
Admin permissions. See Creating a User Account with Proper Access 
Permissions chapter 2  page 4.

3. Verify MSXSPI<hostname> mailbox.
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Chapter 6: Troubleshooting
Advanced Configuration Template Failures
Use Exchange Admin to verify that a MSXSPI<host_name> mailbox exists 
and click on Recipients. In the right pane, a MSXSPI<host_name> user 
must show up for each server which belongs to the site.

4. Verify MeasureWare Agent integration as described in Verifying 
MeasureWare Integration chapter 6  page 8.
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Introduction
Introduction

This chapter lists the Exchange SPI file names, along with their descriptions, 
owners, groups, and permissions. Exchange SPI files are grouped as follows:

� Management server files

� Management server/managed node files

� Managed node files

� Logging and trace files
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Management Server Files
Management Server Files

TEMPLATES FOR OPCCFGUPLD (OVO UPLOAD FACILITY)

All files listed in this table can be found on the management server in the 
following directories (the location of these files varies by platform):

/var/opt/OV/share/tmp/OpC_appl/EXSPI/exspiset/C/

Table 1: Management Server Files

File Description

exspiset.idx OVO upload control file. This 
file defines what is being 
uploaded into OVO: message 
groups, monitor templates, logfile 
templates, applications and 
template groups.

TEMPLATES/LOGFILE
/logfile.dat

Definition file for logfile 
encapsulation. 

TEMPLATES/MONITOR
/monitor.dat

Definition file for OVO 
templates: collector/analyzer 
program, external monitor for 
each metric and file system 
monitor. Contains all details for 
monitoring all metrics.

TEMPLATES/SCHEDULE
/schedule.dat

Definition file for Exchange SPI 
schedule templates.

TEMPLATES/TEMPLGROUP
/templgrp.dat

Definition file for OVO template 
group structure.

TEMPLATES/MSGGROUPS
/msggrps.dat

Definition file for OVO message 
group structure.

TEMPLATES/INTERFACE
/msgi.dat

Definition file for Exchange SPI 
specific error message.
A - 3



Appendix A: File Names
Management Server Files
MISCELLANEOUS MANAGEMENT SERVER FILES

Table 2: Miscellaneous Other Management Server Files

File Description

/etc/opt/OV/share/conf
/OpC/mgmt_sv/
reports/exspi_lc.sql

Report that lists all nodes that have 
Exchange SPI templates assigned (for 
license check).

/opt/OV/EXSPI/bin/exspipv Script to run PerfView as metric operator 
actions and bring up graphs.

/opt/OV/EXSPI/bin
/exspircfg.sh

Script to configure the MSXSPI mailbox of 
the selected node.
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Management Server/Managed Node Files

When you run swinstall, the following monitor and command files are installed 
on the Management Server. They are also installed on managed nodes when you 
distribute monitors, commands and actions from the Management Server to the 
managed nodes.

MONITOR FILES

On Management Server:

/var/opt/OV/share/databases/OpC/mgd_node/customer/ms/
intel/nt/monitor/ 

On Managed Node:

\usr\OV\bin\OpC\monitor

Table 3: Monitor Files 

File Description

/opt/OV/EXSPI/bin
/exspircfg.sh

Script to configure the MSXSPI mailbox of 
the selected node.

 File  Description

 exspi_e2k.exe  Exchange 2000 SPI Collector/Analyzer program.

 exspi_e55.exe  Exchange 5.5  SPI Collector/Analyzer program.

 OVAMTLog2k.dll  Tracking.Log access library for Exchange 2000

 OVAMTLog55.dll  Tracking.Log access library for Exchange 5.5

 OVAMDa.dll   LDAP access library

 hpudm.txt  Internal data file
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Management Server/Managed Node Files
NOTE: All files in Table 3: Monitor Files, are in compressed ".Z" format to improve 
distribution performance.

COMMAND FILES 

Command files are located in the following directories:

Management Server:

/var/opt/OV/share/databases/OpC/mgd_node/customer/ms/
intel/nt/cmds

Managed Node:

\usr\OV\bin\OpC\intel\cmds

All files in this table are in compressed ".Z" format to improve 
distribution performance.

Table 4: Command Files

File Description

exspicol.bat Turns data collection on selected node on/off (for 
maintenance):

-v ON

-v OFF

exspimwd.bat Turns data forwarding to MeasureWare on/off 
(collector/analyzer will only forward data to 
MeasureWare if set to on:

-v ON

-v OFF

exspimwc.exe Configures MeasureWare data collection.

exspidsc.bat MeasureWare configuration program

exspienc.exe For configuring managed node; part of the advanced 
configuration.
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exspi_e2k_cfg.vb
s

For configuring an Exchange 2000 Server mailbox .

exspiDDF.bat For turning on data collection.

m0660.spec
m0661.spec
m0662.spec
m0663.spec
m1002.spec
multi.spec
single.spec
detail.spec

Data log specification

local.cfg Created in the managed node configuration of the 
advanced configuration.

File Description
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Windows Managed Node Files
Windows Managed Node Files

MONITOR TEMPLATES

When templates are distributed from the management server to the Windows 
managed nodes, the monitor templates are encrypted and stored in the following 
directory:

\usr\OV\conf\OpC\<hostname>\
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Logging and Trace Files

Logging and trace files are located in the following directory on the managed 
node:

\usr\OV\exspi\log

Table 5: Logging and Trace Files

File Description

trace When TRACE ON is set in \usr\OV\exspi\defaults, 
tracing and debug information is written to  
\usr\OV\exspi\log. This file can get very large.

exspierror Error information when the Exchange SPI collector/analyzer 
encounters an error condition. Messages written to this file are 
also sent to the OVO message browser.
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Appendix B: Components
This appendix covers the Exchange SPI program components and contains the 
following topics:

� Component Interaction

� Exchange 2000 Templates

� Exchange 5.5 Templates  

� Exchange SPI Message Groups

� Exchange SPI Applications
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Component Interaction
Component Interaction

The Exchange SPI consists of the following logical components: 

� Monitor and schedule templates: Monitor templates define conditions 
for each metric and schedule templates execute metrics per schedule.

� Collector/analyzer programs: Collect the metrics specified in the 
templates at predefined intervals, compares them to permissible levels, 
and forwards them to OVO and MeasureWare. OVO checks the 
threshold values and triggers alarms.

� Windows Event log: Compares generated logfiles against predefined 
logfile templates, and writes error messages to the OVO Management 
Server as needed.

� Graphs and reports: Can be generated using HP PerfView and HP 
ServiceReporter.

� Data Logging: Exchange SPI applications are available for configuring 
data sources, and enabling and disabling data logging.

� Persistent store: Saves metric specific values and reports between 
invocations of the Collector/Analyzer.
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Exchange SPI Templates

Installing the Exchange SPI adds the SPI for MS Exchange template folder to 
the OVO console tree. Double click SPI for MS Exchange to display the 
Exchange 2000 and Exchange 5.5 folders beneath. Double click to open either 
folder, and see the EXSPI Quick Start, Add-Ons and Advanced template groups 
for that version of Exchange.Selecting a template group in the console tree will 
display the templates or template sub-groups within that group, in the details 
pane on the right.

Section of Message Source Templates dialog

For a complete listing of templates with detailed template by template 
specifications, see the HP OpenView Smart Plug-in for Microsoft Exchange 
Server Reference Manual.
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Exchange 2000 Templates 
Table 1: EXSPI-60 Quick Start

Exchange 2000: Quick 
Start Subgroups: 

Templates Descriptions

EXSPI-60 Event Log 
Errors

Templates in this group monitor Exchange 
error messages written to the Windows 
Event log file and when detected, forward 
them to the OVO console

EXSPI-60-Exchange Application 
Errors

60-Exchange System Errors

EXSPI-60 General Data 
Collection

Templates in this group create data stores 
and write data to data stores

EXSPI-60-Log Data (log single 
instance data to OV Performance 
Agent)

EXSPI-60 Information 
Store

Templates in this group collect data on the 
volume of messages processed by both the 
Private and Public Information Store 
during the last logging interval

EXSPI-60-0030 IS Public Average Delivery Time

EXSPI-60-0031 IS Public Average Local Delivery Time

EXSPI-60-0032 IS Public Replication Queue Size

EXSPI-60-0033 IS Public Receive Queue Size

EXSPI-60-0034 IS Public Send Queue Size

EXSPI-60-0040 IS Mailbox Average Delivery Time

EXSPI-60-0041 IS Mailbox Average Local Delivery Time

EXSPI-60-0042 IS Mailbox Receive Queue Size

EXSPI-60-0043 IS Mailbox Send Queue Size

EXSPI-60-0100 IS User Connection Count Low

EXSPI-60-05m-IS 5m Scheduler for metrics in Information 
Store group

EXSPI-60-15m-IS 15m Scheduler for metrics in Information 
Store group
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EXSPI-60-DC-IS Msg Delivery Time Collect data on the average msg delivery 
times in core procs

EXSPI-60-DC-IS Mailbox Msg Vol Collect data on the vol. of messages 
processed by Private IS

EXSPI-60-DC-IS Public Msg Vol Collect data on the vol. of messages 
processed by Public IS

EXSPI-60 Internal 
Errors

Templates in this group collect information 
on errors occurring within the Exchange 
SPI and contains instruction text for fixing 
common problems

EXSPI-60-Messages

EXSPI-60 Message 
Transfer Agent

Templates in this group collect data on the 
length of message queues and volume of 
messages (number and kilobytes) 
processed by the Message Transfer Agent. 
Also templates in this group collect data 
on failed, delayed, and rejected 
inbound/outbound associations and 
messages during the last logging interval

EXSPI-60-0010 MTA Message Delay

EXSPI-60-0011 MTA Work Queue Length

EXSPI-60-0012 MTA Failed Conversions

EXSPI-60-0013 MTA Connection Message Delay

EXSPI-60-0014 MTA Connection Queue Lengths

EXSPI-60-0015 MTA Failed Outbound Associations

EXSPI-60-0016 MTA Rejected Inbound Associations

EXSPI-60-0017 MTA Rejected Inbound Messages 

EXSPI-60-05m-MTA 5m Scheduler for metrics in MTA group 

EXSPI-60-1h-MTA 1h Scheduler for metrics in MTA group

EXSPI-60-DC-MTA & IS Queue Len. Collect data on the length of message 
queues in core procs

EXSPI-60-DC-MTA Message Volume Collect data on the vol. of messages 
processed by MTA

Exchange 2000: Quick 
Start Subgroups: 

Templates Descriptions
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EXSPI-60 SMTP Templates in this group monitor the 
SMTP queue length, Non-Delivery 
Reports (NDRs), and refused connections

EXSPI-60-0050

EXSPI-60-0051

EXSPI-60-0052

EXSPI-60-0053

EXSPI-60-0054

EXSPI-60-0055

EXSPI-60-0056

EXSPI-60-0057

EXSPI-60-1h-SMTP

EXSPI-60-5m-SMTP

EXSPI-60-DcSMTP Message Queues

EXSPI-60-DC-SMTP Message Volume

SMTP Categorizer Queue Length

SMTP Local Queue Length

SMTP Local Retry Queue Length

SMTP Messages Pending Routing

SMTP Remote Queue Length

SMTP Remote Retry Queue Length

SMTP NDR Percentage

SMTP Outbound Connections Refused

1h Scheduler for metrics in SMTP group

5m Scheduler for metrics in SMTP group

Populate Node database with queue 
metrics for graph.

Collect data on the volume of SMTP 
messages processed.

EXSPI-60 Services and 
Processes

Templates in this group monitor Windows 
Services for Exchange by checking to see 
that Exchange services configured with 
Automatic startup are running. 

EXSPI-60-0001 Process Monitor

EXSPI-60-0002 Inactive Process Monitor

EXSPI-60-05m-Serv. & Processes 5m Scheduler for metrics in Services and 
Processes group

EXSPI-60-1001 Process Monitor

EXSPI-60-10m-Serv. & Processes 10m Scheduler for metrics in Services 
and Processes group

EXSPI-60-DC-User Connections Collect data on the number of users

Exchange 2000: Quick 
Start Subgroups: 

Templates Descriptions
B - 7



Appendix B: Components
Exchange SPI Templates
Table 2: EXSPI-60 Add-Ons

Exchange 2000: 
Add-Ons Subgroups

 Templates Descriptions

EXSPI-60 CC:Mail 
Connector

Templates in this group monitor the 
number of messages awaiting delivery to 
Exchange from Lotus cc:Mail, the rate at 
which Non-Delivery Reports (NDRs) are 
being sent from Lotus cc:Mail to 
Exchange and vice versa

EXSPI-60-0090 cc:Mail MTS-IN Queue Length

EXSPI-60-0091 cc:Mail MTS-OUT Queue Length

EXSPI-60-0092 Exchange NDRs to cc:Mail

EXSPI-60-0093 cc:Mail NDRs to Exchange

EXSPI-60-1h-ccMail Connector 1h Scheduler for metrics in cc:Mail 
Connector group

EXSPI-60-5m-ccMail Connector 5m Scheduler for metrics in cc:Mail 
Connector group

EXSPI-60 Chat Service Templates in this group monitor numbers 
of clients logged onto the chat 
community, and notes authentications, 
failures and disconnections related to 
client timeouts, DNS lookup requests and 
DNS lookup failures

EXSPI-60-0830 Microsoft Exchange Chat Service.Active 
DNS logon threads

EXSPI-60-0831
Microsoft Exchange Chat Service.Client 
Timeout Related Disconnects

EXSPI-60-0833 Microsoft Exchange Chat 
Service.Anonymous Clients

EXSPI-60-0834 Microsoft Exchange Chat 
Service.Authenticated Clients

EXSPI-60-0835 Microsoft Exchange Chat 
Service.Authentication Failures

EXSPI-60-0836 Microsoft Exchange Chat Service.Server 
operations queued

EXSPI-60-15m-Chat 15m Scheduler for Chat Metrics

EXSPI-60-Dc-Chat Data Collection Collects data about Exchange Chat 
Service clients and channels.
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EXSPI-Conferencing 
Service/Conference 
Server

Microsoft Exchange 2000 provides 
customers with the ability to schedule and 
participate in online data and video 
conferencing. Exchange SPI monitors and 
reports on the Conferencing Management 
Service, Data Conferencing Service, 
Multipoint Control Units (MCU) Server, 
Video Conferencing Service, and 
Conferencing Bridge Service

EXSPI-60-0800 MSExchangeCONF.Active Conferences

EXSPI-60-0801
MSExchangeDcsMgr.DCOM Calls To 
MCUs

EXSPI-60-0802
MSExchangeDcsMgr.Average Load Per 
MCU

EXSPI-60-10m-Conf
10m Scheduler for active conferencing

EXSPI-60-DC-ConfTrends Collect data on trends in conferencing

EXSPI-Conferencing 
Bridge

Exchange SPI monitors and reports on the 
Conferencing Management Service, Data 
Conferencing Service, Multipoint Control 
Units (MCU) Server, Video Conferencing 
Service, and Conferencing Bridge Service

EXSPI-60-0805 MSExchangeIpconf.Failed User Join 
Attempts

EXSPI-60-0806
MSExchangeIpconf.Video Conferences in 
Progress

EXSPI-60-0807
MSExchangeH323.Incomplete Calls

EXSPI-60-10m-ConfBridge
10m Scheduler for failed user join 
attempts and video conferences in 
progress

EXSPI-MCU Server Templates in this group monitor and 
collect data on the MCU service

EXSPI-60-0803 MSExchangeT120.Active Connections

EXSPI-60-0804 MSExchangeT120.T120 MCU Load

EXSPI-60-10m-MCU 10m Scheduler for MCU conferencing 
trends

Exchange 2000: 
Add-Ons Subgroups

 Templates Descriptions
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EXSPI-60-DC-MCU Collect data on MCU conferencing trends

EXSPI-Instant 
Messaging

Templates in this group monitor numbers 
of current users online, current 
subscriptions for each virtual service 
instance, and message processing time

EXSPI-60-0841 MSExchangeIM Virtual Servers.Current 
Users Online

EXSPI-60-0842 MSExchangeIM Virtual Servers.Current 
Subscriptions

EXSPI-60-0845 MSExchangeIM.Failed Requests/sec

EXSPI-60-0846 MSExchangeIM.Rejected Requests/sec

EXSPI-60-1d-Instant Messaging DC Reporting Collection for Instant 
Messaging

EXSPI-60-Instant Messaging DC Alarming metrics for Instant Messaging

EXSPI-60 Lotus Notes 
Connector

Templates in this group monitor the 
number of messages awaiting delivery to 
Exchange from Lotus Notes, the rate at 
which Non-Delivery Reports (NDRs) are 
being sent from  Lotus Notes to Exchange 
and vice versa

EXSPI-60-0094 Lotus Notes Inbound Queued Messages 
Length

EXSPI-60-0095 Lotus Notes Outbound Queued Messages 
Length

EXSPI-60-0096 Exchange NDRs sent to Lotus Notes

EXSPI-60-0097 Lotus Notes NDRs sent to Microsoft 
Exchange

EXSPI-60-1h-Lotus Notes Connect 1h Scheduler for metrics in Lotus Notes 
Connector group

EXSPI-60-5m-Lotus Notes Connect 5m Scheduler for metrics in Lotus Notes 
Connector group

EXSPI-60 NNTP Templates in this group monitor the failed 
newsfeed connections

 EXSPI-60-0058 Newsfeed Outbound Connections Failed

EXSPI-60-1h-NNTP 1h Scheduler for metrics in NNTP group

Exchange 2000: 
Add-Ons Subgroups

 Templates Descriptions
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EXSPI-60 Site 
Replication Service

Templates in this group monitor site 
replication to verify that synchronization 
updates are being processed efficiently. 

EXSPI-60-0110 DS Pending Synchronizations

EXSPI-60-0111 DS Remaining Updates

EXSPI-60-05m-DS 5m Scheduler for metrics in Directory 
Service group

EXSPI-60 Transaction 
Log

Templates in this group monitor the size 
in MB of the Exchange transaction 
logfiles as well as the disk space used by 
the files. 

EXSPI-60-0005 Low Log File Disk Space

EXSPI-60-0006 Transaction Log File Disc Space

EXSPI-60-15m-Transaction Log 15m Scheduler for metrics in Transaction 
Log group

EXSPI-60-1d-Transaction Log 1d Scheduler for metrics in Transaction 
Log group

Exchange 2000: 
Add-Ons Subgroups

 Templates Descriptions
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Table 3: EXSPI-60 Advanced

Exchange 2000: 
Advanced Subgroups

Templates Descriptions

EXSPI-60 End To End 
Message Ping

Templates in this group monitor e-mail 
service responsiveness by sending an 
e-mail message from one Exchange 
server to another

EXSPI-60-1002 MSExchange End To End Message Ping 
Monitor

EXSPI-60-End to End Message Ping 30 m Scheduler for metric in End To End 
Message Ping group

EXSPI-60 Event Log 
Warnings and 
Information

Templates in this group collect all 
Exchange-related warning and 
information messages from the Windows 
Event Log

EXSPI-60-Exchange Application 
Information

Application Event Log - Notify All 
Information

EXSPI-60-Exchange Application 
Warnings

Application Event Log - Notify All 
Warnings

EXSPI-60-Exchange System 
Information

Application Event Log - Notify All 
Information

EXSPI-60-Exchange System Warnings Application Event Log - Notify All 
Warnings

EXSPI-60 Reporter 
Collection

Templates in this group enable data 
collections for OVO reports

EXSPI-60-DC-Exchange Info Collect data on Exchange Parameters

EXSPI-60-DC-Mailbox Data Collect data about all mailboxes on the 
system

EXSPI-60-DC-Mailbox IS Sum. Data Collect summary data about Mailbox 
Information Store

EXSPI-60-DC-Public Folder Data Collect data about all public folders on 
the system

EXSPI-60-DC-Public IS Sum. Data Collect summary data about Public Info. 
Store (Folders)

EXSPI-60-DC-TrackLog Data Collect Tracking.Log data
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Exchange 5.5 Templates 
Table 4: EXSPI-55 Quick Start 

Exchange 5.5: Quick 
Start Subgroups

Templates Descriptions

EXSPI-55 Directory 
Service

Templates in this group monitor directory 
replication to verify that synchronization 
updates are being processed efficiently. 

EXSPI-55-0110 MSExchangeDS.Remaining Replication 
Synchronizations

EXSPI-55-0111 MSExchangeDS.Remaining Replication 
Updates

EXSPI-55-05m-DS 5m Scheduler for metrics in Directory 
Service group

EXSPI-55-Event Log 
Errors

Templates in this group monitor Exchange 
error messages written to the Windows 
Event log file and when detected, forwards 
them to the OVO console

EXSPI-55-Exchange Errors

EXSPI-55 General Data 
Collection

Templates in this group create data stores 
and writes data to data stores

EXSPI-55-Dc-SMTP Message Volume Collect data on the volume of SMTP 
messages processed.

EXSPI-55-Measurement Data Collector Forward single instance data to 
Measurement Data Collector

EXSPI-55 Information 
Store

Templates in this group collect data on the 
volume of messages processed by both the 
Private and Public Information Store 
during the last logging interval

EXSPI-55-0030 IS Public Average Delivery Time

EXSPI-55-0031 IS Public Average Local Delivery Time

EXSPI-55-0032 IS Public Replication Queue Size

EXSPI-55-0033 IS Public Receive Queue Size

EXSPI-55-0034 IS Public Send Queue Size

EXSPI-55-0040 IS Mailbox Average Delivery Time

EXSPI-55-0041 IS Mailbox Average Local Delivery Time
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EXSPI-55-0042 IS Mailbox Receive Queue Size

EXSPI-55-0043 IS Mailbox Send Queue Size

EXSPI-55-0100 IS User Connection Count Low

EXSPI-55-05m-IS 5m Scheduler for metrics in Information 
Store group

EXSPI-55-15m-IS 15m Scheduler for metrics in Information 
Store group

EXSPI-55-DC-IS Msg Delivery Time Collect data on the average msg delivery 
times in core processes

EXSPI-55-DC-IS Private Msg Vol Collect data on the vol. of messages 
processed by Private IS

EXSPI-55-DC-IS Public Msg Vol Collect data on the vol. of messages 
processed by Public IS

EXSPI-55 Internal 
Errors

Templates in this group collect information 
on errors occurring within the Exchange 
SPI and contains instruction text for fixing 
common problems

EXSPI-55-Messages

EXSPI-55 Message 
Transfer Agent

Templates in this group collect data on the 
length of message queues and volume of 
messages (number and kilobytes) 
processed by the Message Transfer Agent. 
Also collects data on failed, delayed, and 
rejected inbound/outbound associations 
and messages during the last logging 
interval

EXSPI-55-0010 MTA Message Delay

EXSPI-55-0011 MTA Work Queue Length

EXSPI-55-0012 MTA Failed Conversions

EXSPI-55-0013 MTA Connection Message Delay

EXSPI-55-0014 MTA Connection Queue Lengths

EXSPI-55-0015 MTA Failed Outbound Associations

EXSPI-55-0016 MTA Rejected Inbound Associations

EXSPI-55-0017 MTA Rejected Inbound Messages 

Exchange 5.5: Quick 
Start Subgroups

Templates Descriptions
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EXSPI-55-05m-MTA 5m Scheduler for metrics in MTA group 

EXSPI-55-1h-MTA 1h Scheduler for metrics in MTA group

EXSPI-55-DC-MTA & IS Queue Len. Collect data on the length of message 
queues in core processes

EXSPI-55-DC-MTA Message Volume Collect data on the vol. of messages 
processed by MTA

EXSPI-55 Services and 
Processes

Templates in this group monitor Windows 
Services for Exchange by checking to see 
that Exchange services configured with 
Automatic startup are running.

EXSPI-55-0001 Process Monitor

EXSPI-55-0002 Inactive Process Monitor

EXSPI-55-05m-Serv. & Processes 5m Scheduler for metrics in Services and 
Processes group

EXSPI-55-1001 Process Monitor

EXSPI-55-10m-Serv. & Processes 10m Scheduler for metrics in Services 
and Processes group

EXSPI-55-DC-User Connections Collect data on the number of users

EXSPI-55 Transaction 
Log

Templates in this group monitor the size 
in MB of the Exchange transaction 
logfiles as well as the disk space used by 
the files. 

EXSPI-55-0005

EXSPI-55-0006

EXSPI-55-15m-Transaction Log 15m Scheduler for metrics in Transaction 
Log group

EXSPI-55-1d-Transaction Log 1day Scheduler for metrics in Transaction 
Log group

Exchange 5.5: Quick 
Start Subgroups

Templates Descriptions
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Table 5: EXSPI-55 Add-Ons

Exchange 5.5: Add-Ons 
Subgroups

 Templates Descriptions

EXSPI-55 CC:Mail 
Connector

Templates in this group monitor the 
number of messages awaiting delivery to 
Exchange from Lotus cc:Mail, the rate at 
which Non-Delivery Reports (NDRs) are 
being sent from Lotus cc:Mail to 
Exchange and vice versa

EXSPI-55-0090 cc:Mail MTS-IN Queue Length

EXSPI-55-0091 cc:Mail MTS-OUT Queue Length

EXSPI-55-0092 Exchange NDRs to cc:Mail

EXSPI-55-0093 cc:Mail NDRs to Exchange

EXSPI-55-1h-ccMail Connector 1h Scheduler for metrics in cc:Mail 
Connector group

EXSPI-55-5m-ccMail Connector 5m Scheduler for metrics in cc:Mail 
Connector group

EXSPI-55 Internet Mail 
Service

Templates in this group monitor the rate 
at which SMTP connections to other hosts 
are failing or are being rejected for the 
Internet Mail Service, the number of 
messages queued to be converted to 
Internet Mail format as well as the 
number awaiting final delivery, the rate at 
which non-delivery reports are being 
generated for inbound mail and outbound 
mail

EXSPI-55-0060 MSExchangeIMC.Connections Total 
Failed MSExchangeIMC.Connections 
Total Outbound 

EXSPI-55-0061 MSExchangeIMC.Connections Total 
Rejected MSExchangeIMC.Connections 
Total Inbound

EXSPI-55-0062 MSExchangeIMC.Queued MTS-IN

EXSPI-55-0063 MSExchangeIMC.Queued MTS-OUT

EXSPI-55-0064 MSExchangeIMC.Queued Inbound

EXSPI-55-0065 MSExchangeIMC.Queued Outbound

EXSPI-55-0066 MSExchangeIMC.NDRs Total Inbound 
MSExchangeIMC.Inbound Messages 
Total
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EXSPI-55-0067 MSExchangeIMC.NDRs Total Outbound 
MSExchangeIMC.Outbound Messages 
TotalMSExchangeIMC.Outbound 
Messages Total

EXSPI-55-1h-Internet Mail Services 1h Scheduler for metrics in Internet Mail 
Services group

EXSPI-55-5m-Internet Mail Services 5 min. Scheduler for metrics in Internet 
Mail Services group

EXSPI-55-DC-IMS Message Volume Collect data on the vol. of messages 
processed by the IMS

EXSPI-55-DC-IMS Queue Length Collect data on the vol. of messages 
processed by the IMS

EXSPI-55 Lotus Notes 
Connector

Templates in this group monitor the 
number of messages awaiting delivery, 
and  Non-Delivery Reports (NDRs) being 
sent to Exchange from Lotus Notes and 
vice versa

EXSPI-55-0094 Lotus Notes Inbound Queued Messages 
Length

EXSPI-55-0095 Lotus Notes Outbound Queued Messages 
Length

EXSPI-55-0096 Exchange NDRs sent to Lotus Notes

EXSPI-55-0097 Lotus Notes NDRs sent to Microsoft 
Exchange

EXSPI-55-1h-Lotus Notes Connect 1h Scheduler for metrics in Lotus Notes 
Connector group

EXSPI-55-5m-Lotus Notes Connect 5m Scheduler for metrics in Lotus Notes 
Connector group

EXSPI-55 News Service Templates in this group monitor the rate 
inbound and outbound newsfeed 
messages are being rejected because of 
duplicates or errors

EXSPI-55-0080

EXSPI-55-0081

EXSPI-55-1h-News Service 1h Scheduler for News Service metrics

EXSPI-55-DC-News Message Volume Collect data on the vol. of news messages 
processed by IS

Exchange 5.5: Add-Ons 
Subgroups

 Templates Descriptions
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Appendix B: Components
Exchange SPI Templates
Table 6: EXSPI-55 Advanced

Exchange 5.5: Advanced 
Subgroups

Templates Descriptions

EXSPI-55 End To End 
Message Ping

Templates in this group monitor e-mail 
service responsiveness by sending an 
e-mail message from one Exchange 
server to another

EXSPI-55-1002 MSExchange End To End Message Ping 
Monitor

EXSPI-55-End to End Message Ping 30 m Scheduler for metric in End To End 
Message Ping group

EXSPI-55 Ping Config

EXSPI-55 Event Log 
Warnings and 
Information

Templates in this group collect all 
Exchange-related warning and 
information messages from the Windows 
Event Log

EXSPI-55-Exchange Warnings Application Event Log - Notify All 
Warnings

EXSPI-55-Exchange Information Application Event Log - Notify All 
Information

EXSPI-55 Reporter 
Collection

Templates in this group enable data 
collections for OVO reports

EXSPI-55-DC-Exchange Info Collect data on Exchange Parameters

EXSPI-55-DC-Mailbox Data Collect data about all mailboxes on the 
system

EXSPI-55-DC-Private IS Sum. Data Collect summary data about Mailbox 
Information Store

EXSPI-55-DC-Public Folder Data Collect data about all public folders on 
the system

EXSPI-55-DC-Public IS Sum. Data Collect summary data about Public Info. 
Store (Folders)

EXSPI-55-DC-TrackLog Data Collect Tracking.Log data
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Exchange SPI Message Groups
Exchange SPI Message Groups

The Exchange SPI adds the following message group to the OVO Message 
Group Bank:

� EXSPI: Messages generated by Exchange SPI programs containing 
instruction text to help diagnose/remedy problems.

All messages generated by Exchange SPI fall into one of the following message 
groups in the OVO Message Group Bank:

� EX_Perf: Messages regarding performance.

� EX_Fault: Messages regarding error conditions.
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Exchange SPI Applications
Exchange SPI Applications

The Exchange SPI adds the following applications to the OVO Application 
Bank:

EXSPI Admin. Contains configuration and troubleshooting applications 
requiring "root" permission, so it is recommended that the group be 
assigned to the OVO Administrator. This group contains the following 
applications:

� EXSPI Add DataSource: Exchange SPI application to configure data 
sources and start the logging of data.

� Disable Data Logging: Stops Exchange SPI from logging data.

� Enable Data Logging: Starts Exchange SPI data logging. This is 
normally used after Disable Data Logging, to restart data logging.

� EXSPI MBOX Config: Configures Exchange mailbox on selected node 
for access by the Exchange SPI.

� EXSPI Graphs: Contains graphs that can be generated from selected 
metric monitors.

� EXSPI Node Config: Configures the Domain Admin account 
(MSXSPI) on the managed node. This account is for templates 
deployed in the Advanced Configuration section.

� EXSPI Ping Config: Configures the Advanced Configuration 
Template: End To End Message Ping.
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